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Tentang Buku Ini
PERINGATAN! Teks yang ditampilkan dengan simbol ini menunjukkan bahwa jika petunjuk tidak
dijalankan, maka dapat mengakibatkan cedera tubuh atau kematian.

PERHATIAN: Teks yang ditampilkan dengan simbol ini menunjukkan bahwa pelanggaran atas
petunjuk yang diberikan dapat mengakibatkan kerusakan perangkat atau kehilangan informasi.

CATATAN: Teks yang ditampilkan seperti ini berisi informasi tambahan yang penting.
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1 Fitur Diagnostik Komputer

HP Insight Diagnostics
CATATAN: HP Insight Diagnostics tercakup di CD hanya pada model komputer tertentu.

Utilitas HP Insight Diagnostics memungkinkan Anda melihat informasi tentang konfigurasi perangkat
keras pada komputer dan menjalankan uji diagnostik perangkat keras pada subsistem komputer. Utilitas
ini akan memudahkan proses identifikasi, diagnosis, dan menemukan masalah perangkat keras secara
efektif.

Tab Survey akan ditampilkan saat Anda menjalankan HP Insight Diagnostics. Tab ini menunjukkan
konfigurasi komputer yang aktif saat ini. Dari tab Survey, Anda dapat mengakses beberapa kategori
informasi tentang komputer. Tab lainnya berisi informasi tambahan, termasuk pilihan uji diagnostik dan
hasil pengujian. Informasi pada setiap layar utilitas dapat disimpan sebagai file html dan disimpan di
disket atau USB HP Drive Key.

Gunakan HP Insight Diagnostics untuk memastikan semua perangkat yang terpasang pada komputer
dapat dikenali oleh sistem dan berfungsi dengan baik. Menjalankan pengujian adalah pilihan, namun
Anda disarankan untuk menjalankannya setelah memasang atau menyambungkan perangkat baru.

Anda harus menjalankan pengujian, menyimpan hasil pengujian, dan mencetaknya sehingga Anda
memiliki laporan tercetak sebelum menghubungi Customer Support Center.

CATATAN: Perangkat pihak ketiga kemungkinan tidak terdeteksi oleh HP Insight Diagnostics.

Mengakses HP Insight Diagnostics
Untuk mengakses HP Insight Diagnostics, Anda harus membuat Recovery Disc Set, lalu melakukan
boot pada CD yang berisi utilitas. HP Insight Diagnostics juga dapat didownload dari
http://www.hp.com. Untuk informasi lebih lanjut, lihat Mendownload Versi Terbaru HP Insight
Diagnostics pada hal. 5.

CATATAN: HP Insight Diagnostics hanya disertakan sebagai bagian dari Recovery Disk Set pada
model komputer tertentu.

Jika sudah membuat Recovery Disc Set, mulai laksanakan prosedur berikut pada langkah 4.

1. Klik Start > HP Backup and Recovery > HP Backup and Recovery Manager untuk membuka
Backup and Recovery Wizard, kemudian klik Next.

2. Pilih Create a set of recovery discs (Recommended) lalu klik Next.

3. Ikuti petunjuk dalam Wizard untuk membuat Recovery Disc Set.

4. Gunakan Windows Explorer untuk mencari CD yang memuat direktori compaq\hpdiags pada
Recovery Disc Set.
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5. Saat komputer dalam keadaan hidup, masukkan CD ke dalam drive optik pada komputer.

6. Matikan sistem operasi, kemudian matikan komputer.

7. Hidupkan komputer. Sistem akan di-boot dari CD.

CATATAN: Jika sistem tidak mem-boot dari CD yang terdapat di drive optik, Anda harus
mengubah urutan boot pada Computer Setup (F10) agar sistem mencoba boot ke drive optik
sebelum booting ke hard drive. Lihat Panduan Computer Setup (F10) Utility untuk informasi lebih
lanjut.

8. Pilih bahasa yang sesuai, kemudian klik Continue.

CATATAN: Disarankan agar Anda menentukan keyboard default untuk bahasa Anda kecuali
Anda ingin menguji keyboard tertentu.

9. Pada halaman Perjanjian Lisensi Pengguna Akhir, klik Agree untuk menyetujui persyaratan yang
diberikan. Utilitas HP Insight Diagnostics akan dijalankan dengan tab Survey dalam keadaan
ditampilkan.

Tab Survey
Tab Survey menampilkan informasi penting tentang konfigurasi sistem.

Di kolom View level, Anda dapat memilih tampilan Summary untuk melihat data konfigurasi tertentu
atau memilih tampilan Advanced untuk melihat semua data dalam kategori yang dipilih.

Pada bidang Category, Anda dapat memilih kategori informasi berikut ini untuk ditampilkan:

All – Memberikan daftar semua kategori informasi tentang komputer.

Overview – Memberikan daftar informasi umum tentang komputer.

Architecture – Memberikan informasi perangkat BIOS sistem dan PCI.

Asset Control – Menunjukkan nama produk, label aset, nomor seri sistem, dan informasi prosesor.

Communication – Menunjukkan informasi tentang pengaturan port paralel (LPT) dan serial (COM)
komputer, plus informasi tentang pengontrol USB dan jaringan.

Graphics – Menunjukkan informasi tentang pengontrol gambar pada komputer.

Input Devices – Menunjukkan informasi tentang keyboard, mouse, dan perangkat lainnya yang
tersambung ke komputer.

Memory – Menunjukkan informasi tentang memori pada komputer, termasuk slot memori pada papan
sistem dan modul memori lainnya yang terpasang.

Miscellaneous – Menunjukkan informasi versi HP Insight Diagnostics, informasi memori konfigurasi
komputer (CMOS), data papan sistem, dan data BIOS manajemen sistem.

Storage – Menunjukkan informasi tentang media penyimpanan pada komputer. Daftar ini meliputi
semua disk permanen, drive disket, dan drive optik.

System – Menunjukkan informasi tentang model komputer, prosesor, chassis, dan BIOS, plus speaker
internal dan informasi bus PCI.
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Tab Test
Tab Test memungkinkan Anda memilih berbagai komponen sistem untuk diuji. Anda juga dapat memilih
jenis dan mode pengujian.

Terdapat tiga jenis pengujian yang dapat dipilih, yaitu:

● Quick Test – Menyediakan script untuk digunakan oleh masing-masing komponen perangkat
keras tidak diperlukan intervensi baik dalam Unattended mode atau Interactive mode.

● Complete Test – Menyediakan script untuk digunakan oleh masing-masing komponen perangkat
keras yang akan diuji penuh. Interactive mode memiliki lebih banyak pengujian, namun diperlukan
intervensi pengguna.

● Custom Test – Memberikan fleksibilitas paling baik dalam mengontrol pengujian sistem. Custom
Test mode memungkinkan Anda secara spesifik memilih jenis perangkat, pengujian, dan
parameter pengujian yang dijalankan.

Untuk setiap jenis pengujian, ada dua mode pengujian yang dapat dipilih:

● Interactive Mode – Memberikan kontrol maksimum melalui proses pengujian. Dalam Interactive
Mode, perangkat lunak diagnostik akan meminta masukan selama pengujian jika interaksi Anda
diperlukan. Anda juga dapat menentukan apakan pengujian lulus atau gagal.

● Unattended Mode – Tidak menampilkan perintah dan tidak memerlukan interaksi. Jika ditemukan
kesalahan, maka kesalahan tersebut akan ditampilkan setelah pengujian selesai.

Untuk memulai pengujian:

1. Pilih tab Test.

2. Pilih tab untuk jenis pengujian yang akan dijalankan: Quick, Complete, atau Custom.

3. Pilih Test Mode: Interactive atau Unattended.

4. Pilih cara yang Anda inginkan untuk menjalankan pengujian, antara Number of Loops atau Total
Test Time. Jika Anda memilih untuk menjalankan pengujian berdasarkan jumlah loop tertentu,
masukkan jumlah loop yang akan dijalankan. Jika Anda ingin melakukan uji diagnostik selama
rentang waktu tertentu, masukkan jumlah waktu yang diinginkan dalam menit.

5. Jika menjalankan Quick Test atau Complete Test, pilih drive yang akan diuji dari daftar drop-down.
Jika menjalankan Custom Test, klik tombol Expand lalu pilih perangkat yang akan diuji atau klik
tombol Check All untuk memilih semua perangkat.

6. Klik tombol Begin Testing di sudut kanan bawah layar untuk memulai pengujian. Tab Status, yang
dapat Anda gunakan untuk memantau progres pengujian, secara otomatis akan ditampilkan
selama proses pengujian. Setelah pengujian selesai, tab Status akan menunjukkan apakah
perangkat mengalami kegagalan atau keberhasilan.

7. Jika terjadi kesalahan, buka tab Log lalu klik Error Log untuk menampilkan informasi lebih lanjut
dan tindakan yang disarankan.

Tab Status
Tab Status berfungsi menampilkan status pengujian yang dipilih. Jenis pengujian yang dijalankan
(Quick, Complete, atau Custom) juga ditampilkan. Panel progres utama akan menampilkan
persentase penyelesaian rangkaian pengujian. Ketika pengujian berlangsung, tombol Cancel
Testing akan ditampilkan untuk digunakan jika Anda akan membatalkan pengujian.
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Setelah pengujian selesai, tombol Cancel Testing diganti dengan tombol Retest. Tombol Retest
berfungsi untuk menguji ulang rangkaian pengujian yang terakhir dijalankan. Ini memungkinkan Anda
menjalankan kembali rangkaian pengujian tanpa harus memasukkan lagi data ke dalam tab Test.

Tab Status juga menunjukkan:

● Perangkat yang sedang diuji

● Status pengujian (berlangsung, lulus, atau gagal) dari setiap perangkat yang diuji

● Status kemajuan seluruh pengujian dari semua perangkat yang diuji

● Status kemajuan dari setiap perangkat yang diuji

● Waktu pengujian yang telah berlalu dari setiap perangkat yang diuji

Tab Log
Tab Log berisi tab Test Log dan tab Error Log.

Test Log menampilkan semua pengujian yang telah dijalankan, berapa kali pengujian dijalankan,
berapa kali pengujian tersebut gagal, dan waktu yang diperlukan untuk menyelesaikan masing-masing
pengujian. Tombol Clear Test Log akan menghapus isi Test Log.

Error Log menampilkan pengujian untuk perangkat yang gagal sewaktu pengujian diagnostik dan
menyertakan kolom informasi berikut ini.

● Bagian Device menampilkan perangkat yang diuji.

● Bagian Test menampilkan jenis pengujian yang dijalankan.

● Bagian Description menjelaskan kesalahan yang ditemukan dalam uji diagnostik.

● Recommended Repair akan memberikan saran tindakan yang harus dilakukan untuk mengatasi
masalah perangkat keras yang gagal tersebut.

● Failed Count adalah nilai yang menyatakan berapa kali perangkat gagal dalam pengujian.

● Error Code menampilkan kode numerik untuk setiap kegagalan. Kode kesalahan didefinisikan
dalam tab Help.

Tombol Clear Error Log akan menghapus isi Error Log.

Tombol Help
Tab Help berisi tab HP Insight Diagnostics, tab Error Codes, dan tab Test Components.

Tab HP Insight Diagnostics berisi topik bantuan dan termasuk fitur pencarian dan indeks.

Tab Error Codes memberikan penjelasan untuk masing-masing kesalahan kode numerik yang
mungkin muncul dalam tab Error Log yang ada pada tab Log. Setiap kode terkait dengan Message
kesalahan tertentu dan tindakan Recommended Repair untuk membantu mengatasinya. Untuk
menemukan penjelasan kode kesalahan dengan cepat, masukkan kode ke kotak di bagian atas tab
tersebut lalu klik tombol Find Error Codes.

Tab Test Components memperlihatkan informasi tingkat rendah dari pengujian yang dijalankan.
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Menyimpan dan Mencetak Informasi dalam HP Insight Diagnostics
Anda dapat menyimpan informasi yang ditampilkan pada tab Survey dan Log HP Insight Diagnostics
ke disket atau ke USB 2.0 HP Drive Key (64MB atau lebih tinggi). Anda tidak dapat menyimpannya ke
hard drive. Sistem secara otomatis akan membuat file html dengan tampilan yang sama dengan
informasi yang terlihat di layar.

1. Masukkan disket atau USB 2.0 HP Drive Key (kapasitasnya harus 64MB atau lebih). USB 1.0 Drive
Keys tidak didukung.

2. Klik Save di sudut kanan bawah layar.

3. Pilih Save to the floppy atau Save to USB key.

4. Masukkan nama file ke kotak File Name lalu klik tombol Save. File html akan disimpan ke disket
atau USB HP Drive Key.

CATATAN: Jangan keluarkan disket atau USB key sebelum Anda melihat pesan yang
menunjukkan bahwa file html telah ditulis ke media tersebut.

5. Cetak informasi tersebut dari perangkat penyimpanan yang digunakan untuk menyimpannya.

CATATAN: Untuk keluar dari HP Insight Diagnostics, klik tombol Exit Diagnostics di sudut kiri bawah
layar kemudian keluarkan CD dari drive optik.

Mendownload Versi Terbaru HP Insight Diagnostics
1. Kunjungi http://www.hp.com.

2. Klik link Software & Driver Downloads.

3. Masukkan nomor produk (misalnya, dc5800) pada kotak teks, kemudian tekan tombol Enter.

4. Pilih model komputer Anda.

5. Pilih OS Anda.

6. Klik link Diagnostic.

7. Klik HP Insight Diagnostics Offline Edition.

8. Pilih salah satu bahasa lalu klik Download.

CATATAN: File hasil download tersebut juga berisi petunjuk tentang cara membuat CD boot.

Melindungi Perangkat Lunak
Untuk melindungi perangkat lunak dari kehilangan atau kerusakan, Anda harus menyimpan salinan
cadangan dari semua perangkat lunak sistem, aplikasi, dan file terkait yang tersimpan pada hard drive.
Lihat dokumentasi sistem operasi atau utilitas cadangan untuk petunjuk mengenai cara membuat
cadangan file data.
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HP Backup and Recovery Manager
HP Backup and Recovery Manager adalah aplikasi serba guna, mudah digunakan yang memungkinkan
Anda untuk membuat cadangan dan memulihkan hard drive primer pada PC. Aplikasi ini bekerja dalam
Windows untuk membuat cadangan Windows, semua aplikasi dan semua file data. Cadangan dapat
dijadwalkan secara otomatis pada interval tertentu, atau dijalankan secara manual. File penting dapat
diarsipkan secara terpisah dari cadangan biasa.

HP Backup and Recovery Manager telah terinstal pada Recovery Partition hard drive dan
memungkinkan pembuatan Recovery Points untuk mencadangkan tambahan sistem secara
keseluruhan.

Titik Pemulihan dan cadangan file dapat disalin ke CD atau disk DVD, sedangkan semua cadangan
dapat disalin ke jaringan atau hard disk sekunder.

HP sangat menyarankan agar Anda segera membuat Recovery Disc Set sebelum menggunakan
komputer dan menjadwalkan pencadangan Recovery Point otomatis rutin. Cadangan juga dapat disalin
ke jaringan atau hard disk sekunder.

Untuk membuat Set CD Pemulihan:

1. Klik Start > HP Backup and Recovery > HP Backup and Recovery Manager untuk membuka
Backup and Recovery Wizard, kemudian klik Next.

2. Pilih Create a set of recovery discs (Recommended) lalu klik Next .

3. Ikuti petunjuk pada wizard.

PC Recovery mengharuskan boot ulang pada Recovery Partition atau dari Recovery Disc Set. Untuk
melakukan boot ulang Recovery Partition, tekan F11 pada saat pengaktifan bila Anda melihat pesan
"Press F11 for Emergency Recovery".

Untuk informasi lebih lanjut tentang cara menggunakan HP Backup and Recovery Manager, lihat
Panduan Pengguna HP Backup and Recovery Manager dengan memilih Start > HP Backup and
Recovery > HP Backup and Recovery Manager Manual.

CATATAN: Anda dapat memesan Recovery Disc Set dari HP dengan menghubungi pusat dukungan
HP. Kunjungi situs Web berikut, pilih wilayah Anda, lalu klik link Technical support after you buy di
bawah judul Call HP untuk memperoleh nomor telepon pusat dukungan untuk wilayah Anda.

http://welcome.hp.com/country/us/en/wwcontact_us.html
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2 Mengatasi Masalah Tanpa Diagnostik

Bab ini berisi informasi tentang cara mengenali dan memperbaiki masalah kecil, seperti masalah drive
disket, hard drive, drive optik, gambar, audio, memori, dan perangkat lunak. Jika Anda mengalami
masalah pada komputer, lihat tabel dalam bab ini untuk mengetahui kemungkinan penyebab serta solusi
yang disarankan.

CATATAN: Untuk informasi tentang pesan kesalahan tertentu yang mungkin muncul di layar selama
Power-On Self-Test (POST) saat dihidupkan, lihat Lampiran A, Pesan Kesalahan POST
pada hal. 49.

Keselamatan dan Kenyamanan
PERINGATAN! Penyalahgunaan komputer atau kegagalan menciptakan lingkungan kerja yang aman
dan nyaman dapat mengakibatkan ketidaknyamanan atau cedera parah. Lihat Safety & Comfort
Guide di http://www.hp.com/ergo for more information on choosing a workspace and creating a safe
and comfortable work environment. This equipment has been tested and found to comply with the limits
for a Class B digital device, pursuant to Part 15 of the FCC Rules. For more information, refer to the
panduan Informasi Keselamatan & Peraturan.

Sebelum Menghubungi Dukungan Teknis
Jika Anda mengalami masalah dengan komputer, coba solusi yang sesuai di bawah ini untuk
menemukan masalah yang sebenarnya sebelum menghubungi dukungan teknis.

● Jalankan utilitas diagnostik. Lihat Bab 1, Fitur Diagnostik Komputer pada hal. 1 untuk informasi
lebih lanjut.

● Jalankan Drive Protection System (DPS) Self-Test dalam Computer Setup. Lihat Panduan
Computer Setup (F10) Utility untuk informasi lebih lanjut.

● Periksa LED daya di bagian depan komputer untuk melihat apakah berkedip merah. Lampu yang
berkedip adalah kode kesalahan yang akan membantu Anda mendiagnosa masalah tersebut. Lihat
Lampiran A, Pesan Kesalahan POST pada hal. 49 untuk informasi lebih lanjut.

● Jika layar kosong, sambungkan monitor ke port video lain pada komputer jika tersedia. Atau, ganti
monitor dengan monitor lain yang Anda ketahui berfungsi dengan baik.

● Jika Anda bekerja pada jaringan, hubungkan komputer lain dengan kabel yang berbeda ke
sambungan jaringan. Mungkin ada masalah dengan konektor atau kabel jaringan.

● Jika Anda baru saja menambahkan perangkat keras baru, lepaskan perangkat keras tersebut dan
lihat apakah komputer berfungsi dengan baik.

IDWW Keselamatan dan Kenyamanan 7

http://www.hp.com/ergo


● Jika Anda baru saja menginstal perangkat lunak baru, hapus penginstalan perangkat lunak
tersebut dan lihat apakah komputer berfungsi dengan baik.

● Boot komputer ke Safe Mode untuk melihat apakah komputer dapat dihidupkan tanpa memuat
semua driver. Ketika mem-boot sistem operasi, gunakan "Last Known Configuration".

● Lihat dukungan teknis online lengkap di http://www.hp.com/support.

● Lihat bagian Saran Praktis pada hal. 8 berikut dalam panduan ini.

Untuk membantu Anda mengatasi masalah, HP Instant Support Professional Edition akan menyediakan
diagnosis yang dapat Anda lakukan sendiri. Jika Anda ingin menghubungi dukungan HP, gunakan fitur
chatting online di HP Instant Support Professional Edition. Akses HP Instant Support Professional
Edition di: http://www.hp.com/go/ispe.

Untuk informasi dukungan, perangkat lunak, dan driver online terbaru, serta pemberitahuan proaktif,
komunitas pengguna dan pakar HP di seluruh dunia, akses BSC (Business Support Center) di
http://www.hp.com/go/bizsupport.

Jika Anda perlu meminta bantuan teknis, siapkan informasi berikut ini untuk melancarkan panggilan
servis Anda:

● Buat panggilan telepon di depan komputer Anda.

● Catat nomor seri dan nomor ID produk komputer, dan nomor seri monitor Anda sebelum
menelepon.

● Luangkan waktu untuk mengatasi masalah tersebut dengan teknisi servis.

● Lepaskan semua perangkat keras yang baru saja ditambahkan ke sistem Anda.

● Hapus penginstalan semua perangkat lunak yang baru saja diinstal.

● Pulihkan sistem dari Recovery Disc Set yang sudah Anda buat atau, kembalikan sistem ke kondisi
pengaturan pabrik dengan menggunakan HP Backup and Recovery Manager .

PERHATIAN: Pemulihan sistem akan menghapus semua data pada hard drive. Pastikan Anda
membuat cadangan semua file data sebelum menjalankan proses pemulihan.

CATATAN: Untuk informasi tentang penjualan dan peningkatan garansi (Care Pack), hubungi
penyedia layanan atau dealer resmi Anda.

Saran Praktis
Jika Anda mengalami masalah dengan komputer, monitor, atau perangkat lunak, lihat daftar saran
umum berikut ini sebelum mengambil tindakan selanjutnya:

● Periksa apakah komputer dan monitor terhubung ke stopkontak yang berfungsi.

● Periksa apakah sakelar pengatur tegangan (pada model tertentu) sudah diatur ke tegangan yang
sesuai untuk negara/kawasan Anda (115V atau 230V).

● Periksa apakah komputer dihidupkan dan lampu daya hijau menyala.

● Periksa apakah monitor dihidupkan dan lampu monitor hijau menyala.
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● Periksa LED daya di bagian depan komputer untuk melihat apakah berkedip merah. Lampu yang
berkedip adalah kode kesalahan yang akan membantu Anda mendiagnosa masalah. Lihat
Lampiran A, Pesan Kesalahan POST pada hal. 49 untuk informasi lebih lanjut.

● Tingkatkan kontrol kecerahan dan kontras monitor jika monitor redup.

● Tekan terus tombol apa saja. Jika sistem mengeluarkan bunyi bip, berarti keyboard berfungsi
dengan benar.

● Periksa semua kabel apakah ada sambungan yang longgar atau salah.

● Aktifkan komputer dengan menekan tombol apa saja pada keyboard atau menekan tombol daya.
Jika sistem tetap berada pada mode tunda, matikan komputer dengan menekan terus tombol daya
minimal selama 4 detik, kemudian tekan kembali tombol daya untuk menghidupkan ulang
komputer. Jika sistem tidak dapat dimatikan , lepaskan kabel daya, tunggu beberapa detik,
kemudian pasang kembali kabel. Komputer akan dihidupkan ulang jika mulai otomatis setelah daya
terputus diatur pada Computer Setup. Jika tidak dihidupkan ulang, tekan tombol daya untuk
menghidupkan komputer.

● Konfigurasikan ulang komputer setelah memasang papan tambahan non-plug and play atau
pilihan lainnya. Untuk petunjuk, lihat Mengatasi Masalah Pemasangan Perangkat Keras
pada hal. 32.

● Pastikan semua driver perangkat yang diperlukan telah diinstal. Misalnya, jika Anda menggunakan
printer, Anda memerlukan driver untuk model printer tersebut.

● Lepaskan semua media yang dapat di-boot (disket, CD, atau perangkat USB) dari sistem sebelum
dihidupkan.

● Jika Anda menginstal sistem operasi selain yang diinstal pada pengaturan pabrik, periksa untuk
memastikan sistem operasi tersebut didukung pada sistem.

● Jika sistem memiliki beberapa sumber video (adapter tertanam, PCI, atau PCI-Express) terpasang
(video tertanam pada model tertentu) dan monitor tunggal, monitor tersebut harus dihubungkan
ke konektor monitor pada sumber yang dipilih sebagai adapter VGA primer. Saat booting, konektor
monitor lainnya dinonaktifkan dan jika monitor terhubung ke port ini, monitor tidak akan berfungsi.
Anda dapat memilih sumber mana yang akan menjadi sumber VGA default pada Computer Setup.

PERHATIAN: Bila komputer terhubung ke catu daya, selalu ada tegangan pada papan sistem. Anda
harus melepaskan kabel daya dari catu daya sebelum membuka komputer untuk mencegah kerusakan
papan sistem atau komponen komputer.

IDWW Saran Praktis 9



Mengatasi Masalah Umum
Anda mungkin dapat dengan mudah mengatasi masalah umum yang diuraikan dalam bagian ini. Jika
masalah tetap berlanjut dan Anda tidak dapat mengatasinya sendiri atau jika Anda tidak ingin melakukan
perbaikan sendiri, hubungi penyedia atau agen resmi.

PERINGATAN! Bila komputer dihubungkan ke stopkontak, selalu ada tegangan pada papan sistem.
Untuk mengurangi risiko cedera dari sengatan listrik dan/atau permukaan panas, pastikan untuk
melepaskan kabel daya dari stopkontak di dinding dan biarkan komponen sistem internal mendingin
sebelum menyentuhnya.

Temukan LED pada papan sistem. Jika LED menyala, sistem masih memiliki daya. Matikan komputer
dan lepaskan kabel daya dari stopkontak sebelum melanjutkan.

Tabel 2-1  Mengatasi Masalah Umum

Komputer seperti terkunci dan tidak dapat dimatikan saat tombol daya ditekan.

Penyebab Solusi

Pengontrolan perangkat lunak terhadap sakelar daya tidak
berfungsi.

1. Tekan terus tombol daya selama minimal empat detik
hingga komputer mati.

2. Lepaskan kabel daya dari stopkontak.

Komputer tidak bereaksi terhadap keyboard atau mouse USB.

Penyebab Solusi

Komputer berada dalam mode standby . Tekan tombol daya atau tekan tombol apa saja untuk keluar
dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Sistem terkunci. Hidupkan ulang komputer.

Tanggal dan waktu komputer salah.

Penyebab Solusi

Baterai RTC (real-time clock) mungkin perlu diganti.

CATATAN: Menghubungkan komputer ke stopkontak yang
berfungsi baik akan memperpanjang masa pakai baterai RTC.

Terlebih dahulu, atur ulang tanggal dan waktu pada Control
Panel (Computer Setup juga dapat digunakan untuk
menyesuaikan tanggal dan waktu RTC). Jika masalah tetap
berlanjut, ganti baterai RTC. Lihat Panduan Referensi
Perangkat Keras untuk petunjuk cara memasang baterai baru,
atau hubungi penyalur maupun penjual resmi untuk minta
bantuan mengganti baterai RTC.
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Kursor tidak dapat digerakkan menggunakan tombol panah pada keypad.

Penyebab Solusi

Tombol Num Lock mungkin aktif. Tekan tombol Num Lock. Lampu NumLock tidak boleh
menyala jika Anda ingin menggunakan tombol panah. Tombol
Num Lock dapat dinonaktifkan (atau diaktifkan) dalam
Computer Setup.

Tidak ada suara atau volume suara terlalu rendah.

Penyebab Solusi

Volume sistem mungkin diatur rendah atau tidak aktif. 1. Periksa pengaturan F10 BIOS untuk memastikan
speaker sistem internal tidak diatur ke tidak aktif
(pengaturan ini tidak mempengaruhi speaker eksternal).

2. Pastikan speaker eksternal terhubung dengan baik dan
dihidupkan serta kontrol volume speaker diatur dengan
benar.

3. Gunakan kontrol volume sistem yang tersedia pada
sistem operasi untuk memastikan speaker tidak diatur ke
tidak aktif atau untuk memperbesar volume.

Perangkat audio mungkin disambungkan ke soket yang salah
di bagian belakang komputer.

Pastikan perangkat tersebut disambungkan ke soket yang
benar di bagian belakang komputer.

Performa komputer buruk.

Penyebab Solusi

Prosesor panas. 1. Pastikan aliran udara ke komputer tidak terhalang.
Sediakan jarak ruang 10,2 cm (4 inci) pada semua sisi
komputer berventilasi serta di atas monitor agar udara
dapat mengalir.

2. Pastikan kipas terhubung dan berfungsi dengan baik
(kipas tertentu hanya beroperasi jika diperlukan).

3. Pastikan alat pendingin prosesor dipasang dengan
benar.

Hard drive penuh. Pindahkan data dari hard drive untuk menyediakan lebih
banyak ruang pada hard drive.

Memori kurang. Tambahkan memori.

Hard drive terfragmentasi. Lakukan defragmentasi hard drive.

Program yang sebelumnya diakses tidak mengembalikan
memori ke sistem.

Hidupkan ulang komputer.

Terdapat virus pada hard drive. Jalankan program anti virus.

Tabel 2-1  Mengatasi Masalah Umum (Lanjutan)
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Performa komputer buruk.

Penyebab Solusi

Aplikasi yang dijalankan terlalu banyak. 1. Tutup aplikasi yang tidak diperlukan untuk
mengosongkan memori. Beberapa aplikasi yang berjalan
di latar belakang dan dapat ditutup dengan mengklik
kanan setiap ikonnya pada baris tugas. Agar aplikasi
tersebut tidak diaktifkan saat komputer dihidupkan, buka
Start > Run (Windows XP) atau Start > Accessories >
Run (Windows Vista), kemudian ketik msconfig. Pada
tab Startup System Configuration Utility, hapus centang
aplikasi yang tidak ingin diaktifkan secara otomatis.

PERHATIAN: Jangan hentikan aplikasi yang
diperlukan pada saat komputer dihidupkan untuk
pengoperasian sistem operasi dengan benar.

2. Tambahkan memori.

Beberapa jenis aplikasi perangkat lunak, terutama permainan,
membebani subsistem grafis

1. Turunkan resolusi layar aplikasi yang aktif atau lihat
dokumentasi yang menyertai aplikasi untuk mengetahui
cara meningkatkan performa dengan mengatur
parameter aplikasi tersebut.

2. Tambahkan memori.

3. Tingkatkan solusi gambar.

Penyebab tidak diketahui. Hidupkan ulang komputer.

Komputer mati secara otomatis dan LED Daya menyala Merah dua kali, sekali setiap detik, diikuti jeda dua detik, dan
komputer berbunyi bip dua kali. (Bunyi bip berhenti setelah lima kali pengulangan namun LED akan terus menyala).

Penyebab Solusi

Perlindungan panas prosesor diaktifkan:

Kipas mungkin terhalang atau tidak berputar.

ATAU

Alat pendingin tidak tersambung dengan benar ke prosesor.

1. Pastikan ventilasi komputer tidak terhalang dan kipas
pendingin prosesor berfungsi baik.

2. Buka penutup atas, tekan tombol daya, dan lihat apakah
kipas prosesor berputar. Jika kipas prosesor tidak
berputar, pastikan kabel kipas tersambung ke kepala
papan sistem.

3. Jika kipas sudah terpasang, tetapi tidak berputar, ganti
alat pendingin/unit kipas.

4. Hubungi agen atau penyedia layanan resmi.

Tabel 2-1  Mengatasi Masalah Umum (Lanjutan)
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Sistem tidak dapat dihidupkan dan LED di bagian depan komputer tidak menyala.

Penyebab Solusi

Sistem tidak dapat dihidupkan. Tekan terus tombol daya selama kurang dari 4 detik. Jika LED
hard drive berubah hijau, maka:

1. Periksa apakah sakelar pengatur tegangan, yang terletak
di bagian belakang catu daya pada model tertentu, sudah
diatur ke tegangan yang benar. Pengaturan tegangan
yang benar tergantung pada negara/kawasan Anda.

2. Lepaskan kartu tambahan satu per satu hingga lampu
5V_aux pada papan sistem menyala.

3. Ganti papan sistem.

ATAU

Tekan terus tombol daya selama kurang dari 4 detik. Jika LED
hard drive tidak berubah hijau, maka:

1. Periksa apakah unit komputer dihubungkan ke
stopkontak yang berfungsi baik.

2. Buka penutup atas dan periksa apakah kabel tombol
daya telah terpasang dengan benar ke papan sistem.

3. Periksa apakah kedua kabel catu daya terhubung
dengan benar ke papan sistem.

4. Periksa apakah lampu 5V_aux pada papan sistem
menyala. Jika menyala, maka ganti rangkaian kabel
tombol daya.

5. Jika lampu 5V_aux pada papan sistem tidak menyala,
ganti catu daya.

6. Gantilah papan sistem.

Tabel 2-1  Mengatasi Masalah Umum (Lanjutan)
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Mengatasi Masalah Daya
Penyebab dan solusi umum untuk masalah daya tercantum dalam tabel berikut ini.

Tabel 2-2  Mengatasi Masalah Daya

Aliran daya listrik terputus-putus.

Penyebab Solusi

Sakelar pengatur tegangan di bagian belakang rangka
komputer (pada model tertentu) tidak diatur ke tegangan yang
sesuai (115V atau 230V).

Pilih tegangan AC yang sesuai menggunakan sakelar
pengatur tegangan.

Catu daya tidak dapat dihidupkan karena terdapat kesalahan
catu daya internal.

Hubungi penyedia layanan resmi untuk mengganti catu daya.

Komputer mati secara otomatis dan LED Daya menyala Merah dua kali, sekali setiap detik, diikuti jeda dua detik, dan
komputer berbunyi bip dua kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Perlindungan panas prosesor diaktifkan:

Kipas mungkin terhalang atau tidak berputar.

ATAU

Alat pendingin tidak tersambung dengan benar ke prosesor.

1. Pastikan ventilasi udara komputer tidak terhalang dan
kipas pendingin prosesor berfungsi dengan baik.

2. Buka penutup atas, tekan tombol daya, lalu lihat apakah
kipas prosesor berputar. Jika kipas prosesor tidak
berputar, pastikan kabel kipas tersambung ke kepala
papan sistem.

3. Jika kipas telah tersambung, namun tidak berputar, ganti
alat pendingin/unit kipas.

4. Hubungi agen atau penyedia layanan resmi.

LED daya berkedip Merah empat kali, sekali setiap detik diselingi jeda dua detik, dan terdengar bunyi bip empat kali.
(Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Gangguan daya (beban catu daya berlebih). 1. Buka penutup atas dan pastikan kabel catu daya 4 atau
6 kabel telah terpasang pada konektor di papan sistem.

2. Periksa apakah masalah tersebut disebabkan oleh
perangkat, dengan melepaskan SEMUA perangkat yang
terpasang (seperti hard drive, drive disket, atau drive
optik, serta kartu tambahan). Hidupkan sistem. Jika
sistem memasuki POST, maka matikan komputer dan
pasang kembali perangkat satu per satu, kemudian
ulangi prosedur di atas hingga gangguan muncul. Ganti
perangkat yang menyebabkan gangguan tersebut.
Lanjutkan dengan memasang perangkat satu per satu
untuk memastikan bahwa semua perangkat berfungsi
dengan benar.

3. Ganti catu daya.

4. Ganti papan sistem.
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Mengatasi Masalah Disket
Penyebab dan solusi umum untuk masalah disket tercantum dalam tabel berikut ini.

CATATAN: Anda mungkin perlu mengkonfigurasi ulang komputer setelah menambah atau
melepaskan perangkat keras, misalnya drive disket tambahan. Untuk petunjuk, lihat Mengatasi Masalah
Pemasangan Perangkat Keras pada hal. 32.

Tabel 2-3  Mengatasi Masalah Disket

Lampu drive disket terus menyala.

Penyebab Solusi

Disket rusak. Dalam Microsoft Windows XP, klik kanan Start, klik Explore,
lalu pilih salah satu drive. Pilih File > Properties > Tools.
Dalam Error-checking, klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties, lalu pilih tab Tools. Pada Error-checking, klik
Check Now.

Disket dimasukkan secara tidak benar. Keluarkan disket, kemudian masukkan lagi.

Kabel drive tidak terpasang dengan benar. Ulangi pemasangan kabel drive. Pastikan keempat pin pada
kabel daya disket terpasang ke drive.

Drive tidak ditemukan.

Penyebab Solusi

Kabel longgar. Ulangi pemasangan kabel data dan kabel daya drive disket.

Drive yang dapat dilepas tidak terpasang dengan benar. Ulangi pemasangan drive.

Perangkat telah disembunyikan dalam Computer Setup. Jalankan utilitas Computer Setup, kemudian pastikan Device
Available dipilih untuk Legacy Diskette dalam Security >
Device Security.

Drive disket tidak dapat menulis pada disket.

Penyebab Solusi

Disket belum diformat. Format disket.

1. Dari Windows Explorer, pilih drive disket (A).

2. Klik kanan huruf drive, lalu pilih Format.

3. Tetapkan pilihan yang dikehendaki, kemudian klik Start
untuk mulai memformat disket.

Disket tidak dapat ditulis. Gunakan disket lain, atau buka perlindungan penulisan.

Menulis ke drive yang salah. Periksa huruf drive pada informasi jalur.

Kapasitas disket tidak mencukupi. 1. Gunakan disket lain.

2. Hapus file yang tidak diperlukan dari disket.
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Drive disket tidak dapat menulis pada disket.

Penyebab Solusi

Fitur penulisan pada disket lama dinonaktifkan pada Computer
Setup.

Buka Computer Setup, kemudian aktifkan Legacy Diskette
Write dalam Storage > Storage Options.

Disket rusak. Ganti disket yang rusak.

Disket tidak dapat diformat.

Penyebab Solusi

Media tidak valid. Untuk memformat disk dalam MS-DOS, Anda mungkin harus
menuliskan kapasitas disket. Misalnya, untuk memformat
disket berkapasitas 1,44 MB, ketik perintah berikut pada
prompt MS-DOS:

FORMAT A: /F:1440

Disket tidak dapat ditulis. Buka pengunci pada disket.

Fitur penulisan pada disket lama dinonaktifkan pada Computer
Setup.

Buka Computer Setup, kemudian aktifkan Legacy Diskette
Write dalam Storage > Storage Options.

Terjadi masalah pada transaksi disk.

Penyebab Solusi

Struktur direktori buruk, atau terdapat masalah pada file. Dalam Microsoft Windows XP, klik kanan Start, klik Explore,
lalu pilih salah satu drive. Pilih File > Properties > Tools.
Dalam Error-checking, klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties, lalu pilih tab Tools. Pada Error-checking, klik
Check Now.

Drive disket tidak dapat membaca disket.

Penyebab Solusi

Anda menggunakan jenis disket yang tidak sesuai untuk jenis
drive tersebut.

Periksa jenis drive yang digunakan, kemudian gunakan jenis
disket yang sesuai.

Anda membaca drive yang salah. Periksa huruf drive pada informasi jalur.

Disket rusak. Ganti disket dengan yang baru.

Tabel 2-3  Mengatasi Masalah Disket (Lanjutan)
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Muncul pesan "Invalid system disk".

Penyebab Solusi

Pada drive terdapat disket yang tidak berisi file sistem yang
diperlukan untuk menjalankan komputer.

Bila aktivitas drive telah berhenti, keluarkan disket, lalu tekan
Spacebar. Komputer akan dijalankan.

Terjadi kesalahan disket. Hidupkan ulang komputer dengan menekan tombol daya .

Tidak Dapat Melakukan Boot dari Disket.

Penyebab Solusi

Boot disket tidak dapat dilakukan. Ganti dengan disket yang dapat di-boot.

Boot disket dinonaktifkan pada Computer Setup. 1. Jalankan Computer Setup, kemudian aktifkan boot disket
dalam Storage > Boot Order.

2. Jalankan Computer Setup, kemudian aktifkan boot disket
dalam Storage > Storage Options > Removable Media
Boot.

CATATAN: Kedua langkah tersebut harus dijalankan
karena fungsi Removable Media Boot pada Computer Setup
akan menggantikan perintah untuk mengaktifkan Boot
Order.

Mode server jaringan diaktifkan dalam Computer Setup. Jalankan Computer Setup, kemudian nonaktifkan Network
Server Mode dalam Security > Password Options.

Boot media yang dapat dilepas dinonaktifkan pada Computer
Setup.

Jalankan Computer Setup, kemudian aktifkan Removable
Media Boot dalam Storage > Storage Options > Removable
Media Boot.

Tabel 2-3  Mengatasi Masalah Disket (Lanjutan)

IDWW Mengatasi Masalah Disket 17



Mengatasi Masalah Hard Drive
Tabel 2-4  Mengatasi Masalah Hard Drive

Terjadi kesalahan hard drive.

Penyebab Solusi

Pada hard disk terdapat sektor yang rusak, atau hard disk tidak
berfungsi.

1. Dalam Microsoft Windows XP, klik kanan Start, klik
Explore, lalu pilih salah satu drive. Pilih File >
Properties > Tools. Dalam Error-checking, klik Check
Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties, lalu pilih tab Tools. Pada Error-checking,
klik Check Now.

2. Gunakan utilitas untuk mencari dan memblokir
penggunaan sektor yang rusak. Jika perlu, format ulang
hard disk.

Masalah transaksi disk.

Penyebab Solusi

Stuktur direktori buruk, atau terdapat masalah pada file. Dalam Microsoft Windows XP, klik kanan Start, klik Explore,
lalu pilih salah satu drive. Pilih File > Properties > Tools.
Dalam Error-checking, klik Check Now.

Pada Microsoft Windows Vista, klik kanan Start, klik
Explore, lalu klik kanan pada salah satu drive. Pilih
Properties, lalu pilih tab Tools. Pada Error-checking, klik
Check Now.

Drive tidak ditemukan (teridentifikasi).

Penyebab Solusi

Kabel mungkin longgar. Periksa sambungan kabel.

Sistem mungkin tidak secara otomatis mengenali perangkat
yang baru dipasang.

Lihat arahan konfigurasi ulang dalam Mengatasi Masalah
Pemasangan Perangkat Keras pada hal. 32. Jika sistem
masih tidak mengenali perangkat baru, lihat apakah perangkat
tercantum dalam daftar Computer Setup. Jika ya, mungkin
disebabkan oleh masalah driver. Jika tidak, mungkin
disebabkan oleh masalah perangkat keras.

Jika drive ini baru saja dipasang, jalankan utilitas Computer
Setup, kemudian coba tambahkan waktu tunda POST dalam
Advanced > Power-On.

Perangkat tersambung ke port SATA yang diatur tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup, kemudian pastikan Device
Available dipilih untuk port SATA perangkat pada Security >
Device Security.

Drive bereaksi dengan lambat segera setelah daya diaktifkan. Jalankan Computer Setup, kemudian tambah waktu POST
Delay dalam Advanced > Power-On Options.
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Pesan disk/NTLDR nonsistem tidak ada.

Penyebab Solusi

Sistem mencoba memulai operasi dari disket yang tidak dapat
di-boot.

Keluarkan disket dari drive disket.

Sistem mencoba memulai dari hard drive, namun hard drive
mungkin rusak.

1. Masukkan disket yang dapat di-boot ke dalam drive
disket, kemudian hidupkan ulang komputer.

2. Periksa format hard drive menggunakan fdisk: Bila
menggunakan format NTFS, gunakan alat pembaca
pihak ketiga untuk mengevaluasi drive. Bila
menggunakan format FAT32, hard drive tidak dapat
diakses.

File sistem tidak ada atau tidak diinstal dengan benar. 1. Masukkan disket yang dapat di-boot ke dalam drive
disket, kemudian hidupkan ulang komputer.

2. Periksa format hard drive menggunakan Fdisk: Bila
menggunakan format NFTFS, gunakan alat pembaca
pihak ketiga untuk mengevaluasi drive. Bila
menggunakan format FAT32, hard drive tidak dapat
diakses.

3. Instal file sistem dengan sistem operasi yang sesuai.

4. Kembalikan sistem ke titik pemulihan pada HP Backup
and Recovery Manager. Lihat Panduan Pengguna HP
Backup and Recovery Manager pada menu Start
Windows untuk memperoleh informasi lebih lanjut.

Boot hard drive dinonaktifkan pada Computer Setup. Jalankan utilitas Computer Setup, kemudian aktifkan entri hard
drive dalam daftar Storage > Boot Order.

Hard drive yang dapat di-boot tidak dipasang sebagai yang
pertama dalam konfigurasi multi hard drive.

Jika Anda mencoba melakukan boot dari hard drive, pastikan
untuk memasang konektor papan sistem berwarna biru tua
berlabel SATA 0.

Pengontrol hard drive yang dapat di-boot tidak terdaftar
sebagai yang pertama dalam Boot Order.

Jalankan utilitas Computer Setup, lalu pilih Storage > Boot
Order, kemudian pastikan pengontrol hard drive yang dapat
di-boot terdapat tepat dalam entri Hard Drive.

Komputer tidak melakukan boot dari hard drive.

Penyebab Solusi

Perangkat tersambung ke port SATA yang diatur tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup, kemudian pastikan Device
Available dipilih untuk port SATA perangkat pada Security >
Device Security.

Urutan boot salah. Jalankan utilitas Computer Setup, kemudian ubah urutan boot
dalam Storage > Boot Order.

"Emulation Type" hard drive diatur ke "None." Jalankan utilitas Computer Setup, kemudian ubah "Emulation
Type" ke "Hard Disk" pada rincian perangkat dalam Storage >
Device Configuration.

Hard drive rusak. Periksa apakah LED daya pada panel depan berkedip
MERAH, dan apakah terdengar bunyi bip. Lihat Lampiran A,
Pesan Kesalahan POST pada hal. 49 untuk menentukan
kemungkinan penyebab kode lampu berkedip merah dan
bunyi bip tersebut.

Tabel 2-4  Mengatasi Masalah Hard Drive (Lanjutan)
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Komputer tidak melakukan boot dari hard drive.

Penyebab Solusi

Lihat Jaminan Terbatas di Seluruh Dunia untuk mengetahui
persyaratan dan ketentuan yang terkait.

Komputer tampaknya terkunci.

Penyebab Solusi

Program yang sedang digunakan berhenti bereaksi terhadap
perintah.

Coba prosedur "Shut Down" Windows secara normal. Jika
gagal, tekan tombol daya selama empat detik atau lebih, untuk
mematikannya. Untuk menghidupkan ulang komputer, tekan
lagi tombol daya.

Hard drive yang dapat dilepas, tidak dialiri arus daya ke kotak hard drive.

Penyebab Solusi

Kunci pada kotak tidak diatur ke posisi "ON". Masukkan kunci, lalu putar 90 derajat searah jarum jam. LED
hijau di depan kotak akan menyala.

Kabel listrik dari catu daya komputer ke rangka kotak tidak
terpasang dengan benar.

Periksa catu daya untuk memastikannya telah terhubung
dengan benar ke bagian belakang rangka kotak.

Hard drive yang dapat dilepas tidak dikenali oleh komputer.

Penyebab Solusi

Wadah hard drive yang dapat dilepas, tidak seluruhnya masuk
ke dalam rangka kotak atau hard drive tidak seluruhnya masuk
ke dalam wadah.

Dorong wadah ke dalam rangka kotak agar konektor di
belakang rangka masuk dengan benar. Jika masalah belum
berhasil diatasi, matikan komputer, lepaskan wadah, lalu
periksa apakah konektor pada hard drive telah dipasang
dengan benar pada wadah.

Kotak hard drive yang dapat dilepas mengeluarkan bunyi bip dan LED hijau berkedip.

Penyebab Solusi

Alarm kegagalan kipas pada kotak hard drive yang dapat
dilepas, telah diaktifkan.

Matikan komputer, lalu hubungi HP untuk meminta kotak
pengganti.

Tabel 2-4  Mengatasi Masalah Hard Drive (Lanjutan)
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Mengatasi Masalah Pembaca Kartu Media
Tabel 2-5  Mengatasi Masalah Pembaca Kartu Media

Kartu media tidak dapat bekerja pada kamera digital setelah diformat pada Microsoft Windows XP atau Microsoft
Windows Vista.

Penyebab Solusi

Secara default, Windows XP dan Windows Vista akan
memformat semua kartu media yang berkapasitas lebih besar
dari 32 MB dengan format FAT32. Sebagian besar kamera
digital menggunakan format FAT (FAT16 & FAT12) dan tidak
dapat bekerja dengan kartu berformat FAT32.

Format kartu media pada kamera digital atau pilih sistem file
FAT untuk memformat kartu media pada komputer dengan
Windows XP atau Windows Vista.

Kesalahan perlindungan penulisan atau penguncian terjadi saat mencoba menulis ke kartu media.

Penyebab Solusi

Kartu media terkunci. Penguncian kartu media adalah fitur
keamanan yang dapat mencegah penulisan dan penghapusan
dari kartu SD/Stik Memori/kartu PRO.

Jika menggunakan kartu SD, pastikan tab kunci di sebelah
kanan kartu SD tidak berada pada posisi terkunci. Jika
menggunakan Stik Memori/kartu PRO, pastikan tab kunci di
bagian bawah Stik Memori/kartu PRO tidak berada pada posisi
terkunci.

Tidak dapat menulis ke kartu media.

Penyebab Solusi

Kartu media adalah kartu memori hanya baca (ROM). Periksa dokumen produsen yang disertakan dengan kartu
Anda untuk melihat apakah kartu dapat ditulis.

Kartu media terkunci. Penguncian kartu media adalah fitur
keamanan yang dapat mencegah penulisan dan penghapusan
dari kartu SD/Stik Memori/kartu PRO.

Jika menggunakan kartu SD, pastikan tab kunci di sebelah
kanan kartu SD tidak berada pada posisi terkunci. Jika
menggunakan Stik Memori/kartu PRO, pastikan tab kunci di
bagian bawah Stik Memori/kartu PRO tidak berada pada posisi
terkunci.

Tidak dapat mengakses data pada kartu media setelah dimasukkan ke slot.

Penyebab Solusi

Kartu media tidak dimasukkan dengan benar, dimasukkan ke
slot yang salah, atau tidak didukung.

Pastikan kartu dimasukkan dengan benar dengan kontak
berwarna emas di sisi yang benar. Lampu LED hijau akan
menyala jika kartu dimasukkan dengan benar.

Tidak tahu cara mengeluarkan kartu media dengan benar.

Penyebab Solusi

Perangkat lunak komputer digunakan untuk mengeluarkan
kartu dengan aman.

Buka My Computer (Windows XP) atau Computer (Windows
Vista), klik kanan ikon drive yang sesuai, lalu pilih Eject.
Kemudian, tarik keluar kartu dari slotnya.
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Tidak tahu cara mengeluarkan kartu media dengan benar.

Penyebab Solusi

CATATAN: Jangan keluarkan kartu bila lampu LED hijau
menyala

Setelah menginstal pembaca kartu media dan melakukan boot ke Windows, pembaca dan kartu yang dimasukkan
tidak dikenali oleh komputer.

Penyebab Solusi

Sistem operasi memerlukan waktu untuk mengenali perangkat
jika pembaca baru saja diinstal ke komputer dan Anda
menghidupkan PC untuk pertama kalinya.

Tunggu beberapa detik hingga sistem operasi dapat
mengenali pembaca dan port yang tersedia, kemudian
mengenali media yang dimasukkan ke dalam pembaca.

Setelah memasukkan kartu media ke dalam pembaca, komputer mencoba melakukan boot dari kartu media.

Penyebab Solusi

Kartu media yang dimasukkan memiliki kemampuan boot. Jika Anda tidak ingin melakukan boot dari kartu media,
keluarkan kartu saat boot atau jangan tetapkan pilihan untuk
melakukan boot dari kartu media yang dimasukkan selama
boot.

Tabel 2-5  Mengatasi Masalah Pembaca Kartu Media (Lanjutan)
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Mengatasi Masalah Tampilan
Jika Anda mengalami masalah tampilan, lihat dokumen yang disertakan bersama monitor serta daftar
penyebab dan solusi umum dalam tabel berikut.

Tabel 2-6  Mengatasi Masalah Tampilan

Layar kosong (tidak ada video).

Penyebab Solusi

Monitor belum dihidupkan dan lampu monitor belum menyala. Hidupkan monitor dan periksa apakah lampu monitor menyala.

Monitor rusak. Coba monitor lain.

Sambungan kabel salah. Periksa sambungan kabel dari monitor ke komputer dan ke
stopkontak.

Anda mungkin mengaktifkan utilitas pengosongan layar
monitor atau fitur hemat energi.

Tekan sembarang tombol atau klik tombol mouse, dan jika
ada, ketik sandi Anda.

System ROM rusak; sistem berjalan dalam Boot Block
Emergency Recovery Mode (ditunjukkan dengan 8 kali bunyi
bip).

Flash ulang ROM sistem dengan image BIOS terbaru. Untuk
informasi lebih lanjut, lihat bagian "Boot Block Emergency
Recovery Mode" dalam Panduan Manajemen Desktop

Anda menggunakan monitor sinkronisasi tetap yang tidak
sesuai dengan resolusi yang dipilih.

Pastikan monitor dapat menerima kecepatan pindai horizontal
yang sama dengan resolusi yang dipilih.

Komputer berada dalam mode standby. Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Saat mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Kabel monitor dipasangkan ke konektor yang salah. Jika sistem komputer dilengkapi dengan konektor grafis
terpadu dan konektor kartu grafis tambahan, pasang kabel
monitor ke konektor kartu grafis pada bagian belakang
komputer.

Pengaturan monitor pada komputer tidak kompatibel dengan
monitor.

1. Pada Control Panel Windows XP, klik dua kali ikon
Display, lalu pilih tab Settings.

Pada Control Panel Windows Vista, di bawah
Appearance and Personalization, pilih Adjust screen
resolution.

2. Gunakan kontrol geser untuk mengatur ulang resolusi.

Tidak dapat mengaktifkan grafis terpadu setelah menginstal kartu grafis PCI Express.

Penyebab Solusi

Pada sistem dengan grafis terpadu Intel, grafis terpadu tidak
dapat diaktifkan setelah menginstal PCI Express x16.

Grafis terpadu dapat diaktifkan dalam Computer Setup jika
kartu grafis PCI atau PCI Express x1 dipasang, namun tidak
dapat diaktifkan jika terdapat kartu grafis dalam slot PCI
Express x16.
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Layar kosong dan LED daya berkedip Merah lima kali, sekali setiap detik, diselingi jeda dua detik, dan komputer
berbunyi bip lima kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Kesalahan memori video awal 1. Ulangi pemasangan DIMM. Hidupkan sistem.

2. Ganti DIMM satu per satu untuk menemukan modul yang
bermasalah.

3. Ganti memori pihak ketiga dengan memori HP.

4. Ganti papan sistem.

Layar siaga dan LED daya berkedip Merah enam kali, sekali setiap detik, diselingi jeda dua detik, dan komputer
berbunyi bip enam kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Kesalahan grafis video awal. Untuk sistem yang dilengkapi kartu grafis:

1. Ulangi pemasangan kartu grafis. Hidupkan sistem.

2. Ganti kartu grafis.

3. Ganti papan sistem.

Untuk sistem dengan grafis terpadu, ganti papan sistem.

Layar kosong dan LED daya berkedip Merah tujuh kali, sekali setiap detik, diselingi jeda dua detik, dan komputer
berbunyi bip tujuh kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Gangguan papan sistem (masalah ROM yang terdeteksi
sebelum masuk ke video)

Ganti papan sistem.

Monitor tidak berfungsi dengan benar bila digunakan dengan fitur hemat energi.

Penyebab Solusi

Monitor yang tidak memiliki kemampuan hemat energi
digunakan dengan fitur hemat energi.

Nonaktifkan fitur hemat energi monitor.

Karakter redup.

Penyebab Solusi

Kontrol kecerahan dan kontras tidak diatur dengan benar. Ubah kontrol kecerahan dan kontras monitor.

Kabel tidak dipasangkan dengan benar. Pastikan kabel grafis telah terpasang dengan benar ke kartu
grafis dan monitor.

Tabel 2-6  Mengatasi Masalah Tampilan (Lanjutan)
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Video buram atau resolusi yang diminta tidak dapat diaktifkan.

Penyebab Solusi

Jika pengontrol grafis pernah ditingkatkan kemampuannya,
mungkin Anda belum menyesuaikan driver grafis.

Instal driver video yang disertakan dalam kit peningkatan
kemampuan.

Monitor tidak memiliki kemampuan untuk menampilkan
resolusi yang diminta.

Ubah informasi yang diminta.

Kartu grafis rusak. Ganti kartu grafis.

Gambar pecah, bergulung, goyang, atau berkedip.

Penyebab Solusi

Sambungan monitor mungkin tidak lengkap atau monitor
belum disesuaikan dengan benar.

1. Pastikan kabel monitor terpasang dengan benar pada
komputer.

2. Pada sistem dua monitor atau jika ada monitor lain yang
letaknya berdekatan, pastikan medan elektromagnetik
kedua monitor tidak saling mengganggu dengan
menjauhkannya.

3. Lampu fluoresen atau kipas mungkin terlalu dekat ke
monitor.

Medan magnet monitor perlu dihilangkan. Hilangkan medan magnet monitor. Untuk petunjuk, lihat
dokumen yang disertakan bersama monitor.

Gambar tidak berada di tengah.

Penyebab Solusi

Posisi harus diatur. Tekan tombol Menu monitor untuk membuka menu OSD. Pilih
ImageControl/ Horizontal Position atau Vertical Position
untuk mengatur posisi horizontal atau vertikal gambar.

"No Connection, Check Signal Cable" muncul pada layar.

Penyebab Solusi

Kabel video monitor tidak terpasang. Sambungkan kabel video antara monitor dengan komputer.

PERHATIAN: Pastikan komputer telah dimatikan sebelum
memasang kabel video.

"Out of Range" muncul pada layar.

Penyebab Solusi

Resolusi video dan nilai refresh diatur lebih tinggi dari yang
didukung oleh monitor.

Hidupkan ulang komputer, lalu masuk ke Safe Mode. Ubah
pengaturan ke pengaturan yang didukung, kemudian
hidupkan ulang komputer untuk mengaktifkan pengaturan
tersebut.

Tabel 2-6  Mengatasi Masalah Tampilan (Lanjutan)
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Terdengar suara getar atau gemeretak dari dalam monitor CRT saat dihidupkan.

Penyebab Solusi

Koil pembuangan medan magnet pada monitor diaktifkan. Tidak ada. Hal ini normal jika koil pembuangan medan magnet
aktif saat monitor dihidupkan.

Terdengar suara klik dari dalam monitor CRT.

Penyebab Solusi

Pemancar elektronik di dalam monitor diaktifkan. Tidak diperlukan tindakan apapun. Pada jenis monitor tertentu,
bunyi klik merupakan hal yang normal saat monitor dihidupkan
dan dimatikan, ketika masuk dan keluar dari mode siaga, dan
saat berganti resolusi.

Terdengar suara tinggi dari dalam monitor layar datar.

Penyebab Solusi

Pengaturan kecerahan dan/atau kontras terlalu tinggi. Turunkan pengaturan kecerahan dan/atau kontras.

Fokus acak; efek garis, ganda, atau bayangan; garis bergulung horizontal; garis vertikal tipis; atau tidak dapat
menempatkan gambar di tengah layar (hanya monitor layar datar yang menggunakan koneksi input VGA).

Penyebab Solusi

Rangkaian konversi digital pada monitor layar datar mungkin
tidak dapat merespons sinkronisasi output pada kartu grafis
dengan benar.

1. Tetapkan pilihan Auto-Adjustment untuk monitor pada
menu tampilan layar monitor.

2. Sinkronisasikan Clock dan Clock Phase secara manual
pada fungsi tampilan layar. Untuk mendownload SoftPaq
yang akan membantu Anda menjalankan sinkronisasi,
kunjungi situs Web berikut, pilih monitor yang sesuai,
kemudian download SP32347 atau SP32202:
http://www.hp.com/support

Kartu gambar tidak terpasang kuat atau kartu gambar rusak. 1. Ulangi pemasangan kartu grafis.

2. Ganti kartu grafis.

Beberapa simbol yang diketik tidak ditampilkan dengan benar.

Penyebab Solusi

Jenis huruf yang digunakan tidak mendukung simbol tersebut. Gunakan Character Map untuk mencari dan memilih simbol
yang tepat. Klik Start > All Programs > Accessories >
System Tools > Character Map. Anda dapat menyalin simbol
dari Character Map ke dokumen.

Tabel 2-6  Mengatasi Masalah Tampilan (Lanjutan)
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Mengatasi Masalah Audio
Jika komputer memiliki fitur audio dan Anda mengalami masalah audio, lihat daftar penyebab dan solusi
umum dalam tabel berikut.

Tabel 2-7  Mengatasi Masalah Audio

Suara terputus-putus.

Penyebab Solusi

Sumber daya prosesor sedang digunakan oleh aplikasi lain
yang terbuka.

Tutup semua aplikasi intensif prosesor yang terbuka.

Suara asli, yang umumnya terdapat pada berbagai aplikasi
pemutar media.

Hanya pada Windows XP:

1. Dari Control Panel, pilih Sounds and Audio Devices.

2. Pada tab Audio, pilih perangkat dari daftar Sound
Playback.

3. Klik tombol Advanced, lalu pilih tab Performance.

4. Atur indikator geser Hardware acceleration ke None
dan indikator geser Sample rate conversion quality ke
Good, kemudian tes ulang audio.

5. Atur indikator geser Hardware acceleration ke Full dan
indikator geser Sample rate conversion quality ke
Best, kemudian tes ulang audio.

Suara tidak terdengar dari speaker atau headphone.

Penyebab Solusi

Kontrol volume perangkat lunak diturunkan atau dinonaktifkan. Klik dua kali ikon Speaker pada panel tugas, kemudian
pastikan Mute tidak dipilih, lalu gunakan panel geser volume
untuk mengatur volume.

Audio tidak ditampilkan pada Computer Setup. Aktifkan audio dalam Computer Setup: Security >
Device Security > Audio.

Speaker eksternal tidak diaktifkan. Aktifkan speaker eksternal.

Perangkat audio mungkin disambungkan ke soket yang salah
di bagian belakang komputer.

Pastikan perangkat tersebut disambungkan ke soket yang
benar di bagian belakang komputer.

Speaker eksternal disambungkan ke soket audio yang salah
pada kartu suara yang baru dipasang.

Lihat dokumen kartu suara untuk mengetahui sambungan
speaker yang benar.

Audio CD digital tidak diaktifkan. Aktifkan audio CD digital. Pada Device Manager, klik kanan
perangkat CD/DVD, kemudian pilih Properties. Pastikan
Enable digital CD audio for this CD-ROM device dicentang.

Headphone atau perangkat yang terpasang ke konektor
keluaran menonaktifkan suara speaker internal.

Jika terpasang, aktifkan dan gunakan headphone atau
speaker tersebut. Jika tidak digunakan, lepaskan headphone
atau speaker eksternal.
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Suara tidak terdengar dari speaker atau headphone.

Penyebab Solusi

Komputer berada dalam mode standby. Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Speaker internal dinonaktifkan dalam Computer Setup. Aktifkan speaker internal dalam Computer Setup. Pilih
Advanced > Device Options > Internal Speaker.

Suara dari headphone tidak jernih atau mendesis.

Penyebab Solusi

Headphone disambungkan ke konektor output audio
belakang. Konektor output audio belakang digunakan untuk
mengaktifkan perangkat audio dan tidak didesain untuk
penggunaan headphone.

Sambungkan headphone ke konektor headphone di bagian
depan komputer.

Komputer tampak terkunci sewaktu merekam audio.

Penyebab Solusi

Hard disk mungkin penuh. Sebelum merekam, pastikan terdapat cukup ruang kosong
pada hard disk. Anda juga dapat mencoba merekam file audio
dalam format kompresi.

Konektor masukan tidak berfungsi dengan benar.

Penyebab Solusi

Konektor telah dikonfigurasi pada driver audio atau perangkat
lunak aplikasi.

Pada driver audio atau perangkat lunak aplikasi,
konfigurasikan ulang konektor atau tetapkan konektor tersebut
ke nilai default.

Tabel 2-7  Mengatasi Masalah Audio (Lanjutan)
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Mengatasi Masalah Printer
Jika Anda mengalami masalah printer, lihat dokumen yang disertakan dengan printer serta daftar
penyebab dan solusi umum dalam tabel berikut.

Tabel 2-8  Mengatasi Masalah Printer

Printer tidak mencetak.

Penyebab Solusi

Printer belum dihidupkan dan tidak tersambung. Hidupkan printer dan pastikan printer tersambung.

Driver printer yang sesuai untuk aplikasi tersebut belum
diinstal.

1. Instal driver printer yang sesuai untuk aplikasi tersebut.

2. Coba cetak menggunakan perintah MS-DOS:

DIR C:\ > [port printer]

dengan [port printer] sebagai alamat printer yang
digunakan. Jika printer berfungsi, aktifkan driver printer.

Jika komputer Anda berada pada jaringan, Anda mungkin
belum menyambungkannya ke printer.

Buat sambungan yang benar ke printer jaringan.

Printer mungkin tidak berfungsi. Jalankan tes otomatis printer.

Printer tidak dapat dihidupkan.

Penyebab Solusi

Kabelnya mungkin tidak terpasang dengan benar. Pasangkan ulang semua kabel, lalu periksa kabel daya dan
stopkontak.

Printer mencetak informasi yang tidak dapat dipahami.

Penyebab Solusi

Driver printer yang sesuai untuk aplikasi tersebut belum
diinstal.

Instal driver printer yang sesuai untuk aplikasi tersebut.

Kabelnya mungkin tidak terpasang dengan benar. Pasangkan ulang semua kabel.

Memori printer mungkin kelebihan beban. Atur ulang printer dengan mematikannya selama satu menit,
kemudian hidupkan kembali.

Printer tidak tersambung.

Penyebab Solusi

Printer mungkin kehabisan kertas. Periksa baki kertas dan isi bila kosong. Pilih online.
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Mengatasi Masalah Keyboard dan Mouse
Jika Anda mengalami masalah dengan keyboard atau mouse, lihat dokumen yang disertakan bersama
peralatan tersebut serta daftar penyebab dan solusi umum dalam tabel berikut.

Tabel 2-9  Mengatasi Masalah Keyboard

Perintah dan pengetikan dari keyboard tidak dikenali oleh komputer.

Penyebab Solusi

Konektor keyboard tidak terpasang dengan benar. 1. Pada Desktop Windows XP, klik Start > Shut Down.

Pada Desktop Windows Vista, klik Start, klik tanda panah
di sudut kanan bawah menu Start, lalu pilih Shut Down.

2. Setelah shutdown selesai, sambungkan lagi keyboard ke
bagian belakang komputer, kemudian hidupkan ulang
komputer.

Program yang sedang digunakan berhenti bereaksi terhadap
perintah.

Matikan komputer menggunakan mouse, kemudian hidupkan
ulang komputer.

Keyboard perlu diperbaiki. Lihat Jaminan Terbatas di Seluruh Dunia untuk mengetahui
persyaratan dan ketentuan yang terkait.

Komputer berada dalam mode standby. Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Kursor tidak dapat digerakkan menggunakan tombol arrow pada keyboard.

Penyebab Solusi

Tombol Num Lock mungkin aktif. Tekan tombol Num Lock. Lampu NumLock tidak boleh
menyala jika Anda ingin menggunakan tombol arrow. Tombol
Num Lock dapat dinonaktifkan (atau diaktifkan) dalam
Computer Setup.

Tabel 2-10  Mengatasi Masalah Mouse

Mouse tidak bereaksi terhadap gerakan atau terlalu lambat.

Penyebab Solusi

Konektor mouse tidak terpasang dengan benar ke bagian
belakang komputer.

Matikan komputer menggunakan keyboard.

1. Tekan tombol Ctrl dan Esc secara bersamaan (atau tekan
tombol Windows logo) untuk menampilkan menu Start.

2. Gunakan tombol panah untuk memilih Shut Down, lalu
tekan tombol Enter.

3. Setelah shutdown selesai, sambungkan kembali
konektor mouse ke bagian belakang komputer (atau
keyboard), kemudian hidupkan ulang komputer.

Program yang sedang digunakan berhenti bereaksi terhadap
perintah.

Matikan komputer menggunakan keyboard, kemudian
hidupkan ulang komputer.
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Mouse tidak bereaksi terhadap gerakan atau terlalu lambat.

Penyebab Solusi

Mouse mungkin perlu dibersihkan. Lepaskan penutup bola gulir pada mouse, kemudian
bersihkan komponen internal.

Mouse mungkin perlu diperbaiki. Lihat Jaminan Terbatas di Seluruh Dunia untuk mengetahui
persyaratan dan ketentuan yang terkait.

Komputer berada dalam mode standby. Tekan tombol daya untuk keluar dari mode standby.

PERHATIAN: Ketika mencoba keluar dari mode standby,
jangan tekan tombol daya selama lebih dari empat detik. Jika
tidak, komputer akan mati dan Anda akan kehilangan data
yang belum disimpan.

Mouse hanya dapat bergerak ke atas, ke samping, atau gerakannya tidak mulus.

Penyebab Solusi

Bola gulir mouse atau poros enkoder putar yang menyentuh
bola kotor.

Lepaskan bola gulir dari bagian dasar mouse, kemudian
bersihkan komponen internal dengan kit pembersih mouse
yang tersedia di toko komputer.

Tabel 2-10  Mengatasi Masalah Mouse (Lanjutan)
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Mengatasi Masalah Pemasangan Perangkat Keras
Anda mungkin harus mengkonfigurasi ulang komputer setelah menambah atau melepaskan perangkat
keras, misalnya drive tambahan atau kartu tambahan. Jika Anda memasang perangkat plug and play,
Windows akan secara otomatis mengenali perangkat tersebut dan mengkonfigurasi komputer. Jika
Anda memasang perangkat selain plug and play, Anda harus mengkonfigurasi komputer setelah
menyelesaikan pemasangan perangkat keras baru tersebut. Pada Windows, gunakan Add Hardware
Wizard, lalu ikuti petunjuk di layar.

PERINGATAN! Bila komputer disambungkan ke stopkontak , akan selalu ada tegangan pada papan
sistem. Untuk mengurangi risiko cedera akibat sengatan listrik dan/atau permukaan panas, pastikan
Anda melepas kabel daya dari stopkontak dan membiarkan komponen sistem internal mendingin
sebelum menyentuhnya.

Cari LED pada papan sistem. Jika LED menyala, sistem masih memiliki daya. Matikan komputer, lalu
lepas kabel daya dari stopkontak sebelum melanjutkan.

Tabel 2-11  Mengatasi Masalah Pemasangan Perangkat Keras

Perangkat baru tidak dikenali sebagai bagian dari sistem.

Penyebab Solusi

Perangkat tidak ditempatkan atau dipasang dengan benar. Pastikan perangkat tersebut terpasang dengan benar dan
kuat, dan tidak ada pin konektor yang tertekuk.

Kabel perangkat eksternal baru longgar atau kabel daya
terlepas.

Pastikan semua kabel terpasang dengan benar dan kuat, dan
tidak ada pin pada kabel konektor yang tertekuk.

Sakelar daya pada perangkat eksternal baru belum
dihidupkan.

Matikan komputer, hidupkan perangkat eksternal, kemudian
hidupkan komputer untuk mengintegrasikan perangkat ke
sistem komputer.

Ketika sistem menginformasikan tentang perubahan
konfigurasi, Anda menolaknya.

Boot ulang komputer, kemudian ikuti petunjuk untuk menerima
perubahan.

Ketika dipasang, papan plug and play tidak akan secara
otomatis dikonfigurasi jika konfigurasi default menimbulkan
konflik dengan perangkat lain.

Gunakan Windows Device Manager untuk membatalkan
pilihan pengaturan otomatis bagi papan tersebut, kemudian
pilih konfigurasi dasar yang tidak menimbulkan konflik sumber
daya. Anda juga dapat menggunakan Computer Setup untuk
mengkonfigurasi ulang atau menonaktifkan perangkat agar
mengatasi konflik sumber daya tersebut.

Port USB pada komputer dinonaktifkan pada Computer Setup. Buka Computer Setup (F10), lalu aktifkan port USB.
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Komputer tidak dapat dihidupkan.

Penyebab Solusi

Modul memori yang digunakan untuk peningkatan
kemampuan tidak sesuai atau modul memori dipasang pada
lokasi yang salah.

1. Lihat dokumen yang disertakan bersama sistem untuk
menentukan apakah Anda menggunakan modul memori
yang benar dan memeriksa apakah pemasangan sudah
benar.

CATATAN: DIMM 1 harus selalu terpasang.

2. Perhatikan bunyi bip dan LED yang menyala di bagian
depan komputer. Bip dan LED berkedip adalah kode
untuk masalah tertentu.

3. Jika Anda masih belum dapat mengatasi masalah,
hubungi Dukungan Pelanggan.

LED daya berkedip Merah lima kali, sekali setiap detik, diselingi jeda dua detik, kemudian komputer berbunyi bip lima
kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Pemasangan memori salah atau memori rusak. PERHATIAN: Untuk menghindari kerusakan pada DIMM
atau papan sistem, Anda harus melepaskan kabel daya
komputer sebelum mencoba mengatur ulang dudukan,
memasang, atau melepaskan modul DIMM.

1. Ulangi pemasangan DIMM. Hidupkan sistem.

2. Ganti DIMM satu per satu untuk menemukan modul yang
bermasalah.

CATATAN: DIMM 1 harus selalu terpasang.

3. Ganti memori pihak ketiga dengan memori HP.

4. Ganti papan sistem.

LED daya berkedip Merah enam kali, sekali setiap detik, diselingi jeda dua detik, kemudian komputer berbunyi bip
enam kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Kartu grafis tidak terpasang dengan benar atau rusak, atau
papan sistem rusak.

Untuk sistem yang dilengkapi kartu grafis:

1. Ulangi pemasangan kartu grafis. Hidupkan sistem.

2. Ganti kartu grafis.

3. Ganti papan sistem.

Untuk sistem dengan grafis terpadu, ganti papan sistem.

Tabel 2-11  Mengatasi Masalah Pemasangan Perangkat Keras (Lanjutan)
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LED daya berkedip Merah sepuluh kali, sekali setiap detik, diselingi jeda dua detik, kemudian komputer berbunyi bip
sepuluh kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Kartu tambahan rusak. 1. Periksa setiap kartu tambahan dengan melepaskan kartu
satu per satu (jika terpasang banyak kartu), kemudian
hidupkan sistem untuk melihat apakah masalah teratasi.

2. Setelah kartu yang rusak ditemukan, lepaskan, lalu ganti
kartu tambahan tersebut.

3. Ganti papan sistem.

Tabel 2-11  Mengatasi Masalah Pemasangan Perangkat Keras (Lanjutan)
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Mengatasi Masalah Jaringan
Beberapa penyebab dan solusi umum untuk masalah jaringan tercantum dalam tabel berikut ini.
Panduan ini tidak membahas proses debug kabel jaringan.

Tabel 2-12  Mengatasi Masalah Jaringan

Fitur Wake-on-LAN tidak berfungsi.

Penyebab Solusi

Wake-on-LAN tidak diaktifkan.

CATATAN: Beberapa NIC tertentu dilengkapi dengan applet
konfigurasi yang memungkinkan kontrol dan konfigurasi fitur
bangun secara lebih rinci. Lihat dokumen yang disertakan
dengan NIC untuk informasi lebih lanjut.

Untuk mengaktifkan Wake-on-LAN pada Windows XP:

1. Pilih Start > Control Panel.

2. Klik dua kali Network Connections.

3. Klik dua kali Local Area Connection.

4. Klik Properties.

5. Klik Configure.

6. Klik tab Power Management, kemudian pilih kotak
centang Allow this device to bring the computer out
of standby.

Untuk mengaktifkan Wake-on-LAN pada Windows Vista:

1. Pilih Start > Control Panel.

2. Di bawah Network and Internet, pilih View network
status and tasks.

3. Dalam daftar Tasks, pilih Manage network
connections.

4. Klik dua kali Local Area Connection.

5. Klik tombol Properties.

6. Klik tombol Configure.

7. Klik tab Power Management, kemudian pilih kotak
centang Allow this device to bring the computer out
of standby.

Driver jaringan tidak mendeteksi pengontrol jaringan.

Penyebab Solusi

Pengontrol jaringan dinonaktifkan. 1. Jalankan Computer Setup, kemudian aktifkan pengontrol
jaringan.

2. Aktifkan pengontrol jaringan pada sistem operasi melalui
Device Manager.

Driver jaringan tidak sesuai. Lihat dokumen pengontrol jaringan untuk driver yang sesuai
atau untuk dapatkan driver versi terbaru dari situs Web
produsen.
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Lampu link status jaringan tidak menyala.

CATATAN: Lampu status jaringan seharusnya berkedip bila dilakukan aktivitas jaringan.

Penyebab Solusi

Jaringan aktif tidak terdeteksi. Periksa apakah sambungan kabel dan perangkat sudah
benar.

Pengontrol jaringan tidak diatur dengan benar. Periksa status perangkat dari Windows, seperti Device
Manager, untuk mengetahui pemasangan driver, serta applet
Network Connections di Windows untuk mengetahui status
link.

Pengontrol jaringan dinonaktifkan. 1. Jalankan Computer Setup, kemudian aktifkan pengontrol
jaringan.

2. Aktifkan pengontrol jaringan pada sistem operasi melalui
Device Manager.

Driver jaringan tidak diinstal dengan benar. Ulangi penginstalan driver jaringan.

Sistem tidak dapat melakukan penginderaan otomatis untuk
jaringan.

Nonaktifkan kemampuan penginderaan otomatis dan arahkan
sistem untuk masuk ke mode operasi yang benar.

Diagnostik melaporkan kegagalan.

Penyebab Solusi

Kabel tidak terpasang dengan benar. Pastikan kabel terpasang dengan benar ke konektor jaringan
dan ujung kabel yang lainnya terpasang dengan benar ke
perangkat yang sesuai.

Kabel terpasang ke konektor yang salah. Pastikan kabel terpasang ke konektor yang benar.

Terdapat masalah pada kabel atau perangkat yang
tersambung ke ujung kabel yang lain.

Pastikan kabel dan perangkat yang tersambung pada kabel
tersebut beroperasi dengan benar.

Interupsi pengontrol jaringan digunakan bersama dengan
papan tambahan.

Pada menu Advanced dalam Computer Setup, ubah
pengaturan sumber daya untuk papan.

Pengontrol jaringan rusak. Hubungi penyedia servis resmi.

Diagnostik berhasil, namun komputer tidak berkomunikasi dengan jaringan.

Penyebab Solusi

Driver jaringan belum diinstal, atau parameter driver tidak
cocok dengan konfigurasi yang aktif.

Pastikan driver jaringan telah diaktifkan dan parameter driver
cocok dengan konfigurasi pengontrol jaringan.

Pastikan klien jaringan dan protokol yang diinstal sudah benar.

Pengontrol jaringan tidak dikonfigurasi untuk komputer. Pilih ikon Network pada Control Panel, kemudian
konfigurasikan pengontrol jaringan.

Tabel 2-12  Mengatasi Masalah Jaringan (Lanjutan)
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Pengontrol jaringan berhenti bekerja jika papan tambahan ditambahkan pada komputer.

Penyebab Solusi

Interupsi pengontrol jaringan digunakan bersama dengan
papan tambahan.

Pada menu Advanced dalam Computer Setup, ubah
pengaturan sumber daya untuk papan.

Pengontrol jaringan memerlukan driver. Pastikan driver tidak terhapus secara tidak sengaja ketika
berlangsung penginstalan driver untuk papan tambahan yang
baru.

Papan tambahan yang dipasang adalah kartu jaringan (NIC)
dan menimbulkan konflik dengan NIC tertanam.

Pada menu Advanced dalam Computer Setup, ubah
pengaturan sumber daya untuk papan.

Pengontrol jaringan berhenti bekerja tanpa sebab yang jelas.

Penyebab Solusi

File yang berisi driver jaringan bermasalah. Instal ulang driver jaringan menggunakan Recovery Disc Set
yang dibuat dari Partisi Pemulihan hard drive.

Kabel tidak terpasang dengan benar. Pastikan kabel terpasang dengan benar ke konektor jaringan
dan ujung kabel yang lainnya terpasang dengan benar ke
perangkat yang sesuai.

Pengontrol jaringan rusak. Hubungi penyedia servis resmi.

Kartu jaringan yang baru tidak melakukan boot.

Penyebab Solusi

Kartu jaringan baru tersebut mungkin rusak atau tidak
memenuhi spesifikasi standar industri.

Pasang NIC yang memenuhi standar industri dan berfungsi
baik, atau ubah urutan boot agar boot dilakukan dari sumber
lain.

Tidak dapat terhubung ke server jaringan bila mencoba Remote System Installation.

Penyebab Solusi

Pengontrol jaringan tidak dikonfigurasi dengan benar. Pastikan Network Connectivity benar, DHCP Server tersedia,
dan Remote System Installation Server berisi driver NIC untuk
NIC yang Anda gunakan.

Utilitas konfigurasi sistem melaporkan bahwa EEPROM tidak terprogram.

Penyebab Solusi

EEPROM tidak terprogram. Hubungi penyedia servis resmi.

Tabel 2-12  Mengatasi Masalah Jaringan (Lanjutan)
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Mengatasi Masalah Memori
Jika Anda mengalami masalah memori, beberapa penyebab dan solusi umum tercantum dalam tabel
berikut ini.

PERHATIAN: Daya mungkin masih mengalir ke DIMM ketika komputer dimatikan (tergantung
pengaturan Management Engine (ME)). Untuk menghindari kerusakan pada DIMM atau papan sistem,
Anda harus melepaskan kabel daya komputer sebelum mencoba mengatur ulang dudukan, memasang,
atau melepaskan modul DIMM.

Untuk sistem yang mendukung memori ECC, HP tidak mendukung penggabungan memori ECC dengan
selain ECC. Jika digabung, komputer tidak dapat melakukan boot pada sistem operasi.

CATATAN: Jumlah memori mungkin terpengaruh oleh konfigurasi dengan pengaktifan Management
Engine (ME). ME menggunakan memori sistem 8 MB pada mode saluran tunggal atau memori 16MB
pada mode saluran ganda untuk mendownload, mendekompresi, dan menjalankan firmware ME untuk
fungsi Out-of-Band (OOB), penyimpanan data pihak ketiga, dan fungsi manajemen lainnya.

Tabel 2-13  Mengatasi Masalah Memori

Sistem tidak melakukan boot atau tidak berfungsi dengan benar setelah pemasangan modul memori tambahan.

Penyebab Solusi

Modul memori tidak terpasang dalam soket XMM1 (atau
DIMM1).

Pastikan modul memori terpasang dalam soket XMM1 hitam
(atau DIMM1) pada papan sistem. Soket ini harus berisi modul
memori.

Jenis atau tingkat kecepatan modul memori tidak cocok untuk
sistem atau modul memori baru tidak terpasang dengan benar.

Ganti modul dengan perangkat yang memenuhi standar
industri dan sesuai untuk komputer. Pada model tertentu,
modul memori ECC dan selain ECC tidak dapat digabungkan.

Kesalahan memori habis.

Penyebab Solusi

Konfigurasi memori tidak diatur dengan benar. Gunakan Device Manager untuk memeriksa konfigurasi
memori.

Anda kekurangan memori untuk menjalankan aplikasi. Lihat dokumen aplikasi untuk mengetahui kebutuhan
memorinya.

Hitungan memori dalam POST salah.

Penyebab Solusi

Modul memori mungkin tidak dipasang dengan benar. Periksa apakah modul memori telah terpasang dengan benar
dan apakah modul yang digunakan sudah benar.

Gambar terpadu mungkin menggunakan memori sistem. Tidak diperlukan tindakan apapun.
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Kesalahan memori tidak cukup sewaktu pengoperasian.

Penyebab Solusi

Terlalu banyak program Terminate and Stay Resident (TSR)
yang diinstal.

Hapus TSR yang tidak diperlukan.

Anda kekurangan memori untuk aplikasi. Periksa kebutuhan memori untuk aplikasi atau tambah memori
komputer.

LED daya berkedip Merah lima kali, sekali setiap detik, diselingi jeda dua detik, kemudian komputer berbunyi bip lima
kali. (Bunyi bip berhenti setelah lima kali pengulangan, namun LED akan terus menyala.)

Penyebab Solusi

Pemasangan memori salah atau memori rusak. 1. Ulangi pemasangan DIMM. Hidupkan sistem.

2. Ganti DIMM satu per satu untuk menemukan modul yang
bermasalah.

3. Ganti memori pihak ketiga dengan memori HP.

4. Ganti papan sistem.

Tabel 2-13  Mengatasi Masalah Memori (Lanjutan)
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Mengatasi Masalah Prosesor
Jika Anda mengalami masalah prosesor, beberapa penyebab dan solusi umum tercantum dalam tabel
berikut ini.

Tabel 2-14  Mengatasi Masalah Prosesor

Performa komputer buruk.

Penyebab Solusi

Prosesor panas. 1. Pastikan aliran udara ke komputer tidak terhalang.

2. Pastikan kipas terhubung dan berfungsi dengan baik
(kipas tertentu hanya beroperasi jika diperlukan).

3. Pastikan alat pendingin prosesor dipasang dengan
benar.

LED daya berkedip Merah tiga kali, sekali setiap detik, diselingi jeda dua detik.

Penyebab Solusi

Prosesor tidak terpasang dengan benar atau tidak dipasang
sama sekali.

1. Periksa apakah prosesor ada.

2. Ulangi pemasangan prosesor.
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Mengatasi Masalah CD-ROM dan DVD
Jika Anda mengalami masalah CD-ROM atau DVD, lihat daftar penyebab umum beserta solusinya
dalam tabel berikut atau lihat dokumen yang menyertai perangkat tambahan tersebut.

Tabel 2-15  Mengatasi Masalah CD-ROM dan DVD

Sistem tidak melakukan boot dari drive CD-ROM atau DVD.

Penyebab Solusi

Perangkat tersambung ke port SATA yang telah
disembunyikan dalam utilitas Computer Setup.

Jalankan utilitas Computer Setup, kemudian pastikan Device
Available dipilih untuk port SATA perangkat pada Security >
Device Security.

Media Boot yang Dapat Dilepas dinonaktifkan dalam utilitas
Computer Setup.

Jalankan utilitas Computer Setup, kemudian aktifkan boot
untuk media yang dapat dilepas dalam Storage > Storage
Options. Pastikan CD-ROM diaktifkan dalam Storage > Boot
Order.

Network Server Mode diaktifkan dalam Computer Setup. Jalankan utilitas Computer Setup, kemudian nonaktifkan
Network Server Mode dalam Security > Password Options.

Pada drive terdapat CD yang tidak dapat di-boot. Masukkan CD boot ke dalam drive.

Urutan boot tidak sesuai. Jalankan utilitas Computer Setup, kemudian ubah urutan boot
dalam Storage > Boot Order.

Drive tidak ditemukan (teridentifikasi).

Penyebab Solusi

Kabel mungkin longgar. Periksa sambungan kabel.

Sistem mungkin tidak secara otomatis mengenali perangkat
yang baru dipasang.

Lihat arahan konfigurasi ulang dalam Mengatasi Masalah
Pemasangan Perangkat Keras pada hal. 32. Jika sistem masih
tidak mengenali perangkat baru, lihat apakah perangkat
tercantum dalam daftar Computer Setup. Jika ya, mungkin
disebabkan oleh masalah driver. Jika tidak, mungkin
disebabkan oleh masalah perangkat keras.

Jika drive ini baru saja dipasang, jalankan utilitas Computer
Setup, kemudian coba tambahkan waktu penundaan POST
dalam Advanced > Power-On Options.

Perangkat tersambung ke port SATA yang diatur tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup, kemudian pastikan Device
Available dipilih untuk port SATA perangkat pada Security >
Device Security.

Drive bereaksi dengan lambat segera setelah dinyalakan. Jalankan Computer Setup, kemudian tambah waktu POST
Delay dalam Advanced > Power-On Options.

Perangkat CD-ROM atau DVD tidak terdeteksi atau driver tidak diinstal.

Penyebab Solusi

Drive tidak tersambung atau tidak dikonfigurasi dengan benar. Lihat dokumen yang disertakan dengan perangkat tambahan
tersebut.
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Drive DVD tidak dapat memutar film.

Penyebab Solusi

Film tersebut memiliki kode yang tidak sesuai untuk negara/
kawasan Anda.

Lihat dokumen yang disertakan dengan menyertai drive DVD
tersebut.

Perangkat lunak dekoder tidak diinstal. Instal perangkat lunak dekoder.

Media rusak. Ganti media.

Peringkat film termasuk yang diblokir oleh pengawasan orang
tua.

Gunakan perangkat lunak DVD untuk membatalkan
pengawasan orang tua.

Media dipasang terbalik. Pasang lagi media.

CD tidak dapat dikeluarkan (tempat pengisian).

Penyebab Solusi

CD tidak dimasukkan dengan benar dalam drive. Matikan komputer, kemudian sisipkan sebatang logam yang
runcing ke dalam lubang darurat, lalu tekan dengan kuat.
Perlahan, tarik sepenuhnyatempat CD keluar dari drive,
kemudian ambil CD.

Drive CD-ROM, CD-RW, DVD-ROM, atau DVD-R/RW tidak dapat membaca disk atau terlalu lama memulai
pengoperasian.

Penyebab Solusi

Media dimasukkan secara terbalik. Masukkan kembali media dengan label menghadap atas.

Drive DVD-ROM terlalu lama memulai operasi karena harus
menentukan jenis media yang akan diputar, misalnya audio
atau video.

Tunggu sekurangnya 30 detik untuk memberi kesempatan
pada drive DVD-ROM untuk menentukan jenis media yang
akan diputar. Jika disk tersebut masih belum dapat diputar,
baca solusi lain yang tercantum untuk topik ini.

CD atau DVD tersebut kotor. Bersihkan CD atau DVD dengan kit pembersih CD, yang dapat
diperoleh di toko komputer.

Windows tidak mendeteksi drive CD-ROM atau DVD-ROM. 1. Gunakan Device Manager untuk menghapus
penginstalan perangkat.

2. Hidupkan ulang komputer, dan biarkan Windows
mendeteksi driver CD atau DVD tersebut.

Perekaman atau penyalinan CD tidak dapat atau sulit dilakukan.

Penyebab Solusi

Jenis media tidak sesuai atau berkualitas buruk. 1. Coba gunakan kecepatan yang lebih rendah untuk
merekam.

2. Periksa apakah media yang digunakan untuk drive sudah
benar.

3. Coba merek media yang lain. Kualitas media dari setiap
produsen berbeda.

Tabel 2-15  Mengatasi Masalah CD-ROM dan DVD (Lanjutan)

42 Bab 2   Mengatasi Masalah Tanpa Diagnostik IDWW



Komputer USDT melakukan boot terlalu lambat setelah menghapus drive CD-ROM atau DVD.

Penyebab Solusi

Sistem mencari drive saat melakukan boot karena kabel drive
masih tersambung ke papan sistem.

Lepaskan kabel drive dari papan sistem.

Mengatasi Masalah Drive Key
Jika Anda mengalami masalah Drive Key, beberapa penyebab umum beserta solusinya tercantum
dalam tabel berikut ini.

Tabel 2-16  Mengatasi Masalah Drive Key

USB Drive Key tidak terlihat sebagai huruf drive dalam Windows.

Penyebab Solusi

Huruf drive setelah drive terakhir tidak tersedia. Ganti huruf drive default untuk Drive Key tersebut dalam
Windows.

USB Drive Key tidak ditemukan (teridentifikasi).

Penyebab Solusi

Perangkat tersambung ke port USB yang diatur tersembunyi
pada Computer Setup.

Jalankan utilitas Computer Setup, kemudian pastikan "Device
available" dipilih untuk "All USB Ports" dan "Front USB Ports"
dalam Security > Device Security.

Perangkat tidak terpasang dengan benar sebelum dihidupkan. Pastikan perangkat dimasukkan sepenuhnya ke dalam port
USB sebelum menghidupkan daya sistem

Sistem tidak melakukan boot dari USB Drive Key.

Penyebab Solusi

Urutan boot tidak benar. Jalankan utilitas Computer Setup, kemudian ubah urutan boot
dalam Storage > Boot Order.

Media Boot yang Dapat Dilepas dinonaktifkan dalam utilitas
Computer Setup.

Jalankan utilitas Computer Setup, kemudian aktifkan boot
untuk media yang dapat dilepas dalam Storage > Storage
Options. Pastikan USB diaktifkan dalam Storage > Boot
Order.

Boot image pada perangkat tidak dapat dilakukan. Ikuti prosedur yang dijelaskan dalam bagian "ROM Flash:
Membuat Replika Konfigurasi Pengaturan: Membuat
Perangkat Boot: Perangkat Media USB Flash" pada Panduan
Referensi Servis.

Komputer melakukan boot dengan DOS setelah membuat Drive Key boot.

Penyebab Solusi

Boot Drive Key dapat dilakukan. Instal Drive Key hanya setelah boot sistem operasi dilakukan.
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Mengatasi Masalah Komponen Panel Depan
Jika Anda mengalami masalah pada perangkat yang disambungkan ke panel depan, lihat penyebab
umum beserta solusinya dalam tabel berikut ini.

Tabel 2-17  Mengatasi Masalah Komponen Panel Depan

Perangkat USB, headphone, atau mikrofon tidak dikenal oleh komputer.

Penyebab Solusi

Perangkat tidak tersambung dengan benar. 1. Matikan komputer.

2. Sambungkan ulang perangkat ke bagian depan
komputer kemudian hidupkan ulang komputer.

Perangkat tidak mendapat daya listrik yang cukup. Jika perangkat USB memerlukan daya AC, pastikan salah satu
sambungan terpasang ke perangkat dan yang lagi ke
stopkontak.

Driver perangkat yang diperlukan belum diinstal. 1. Instal driver printer yang sesuai untuk perangkat.

2. Anda mungkin perlu melakukan boot ulang komputer.

Kabel dari perangkat ke komputer tidak berfungsi. 1. Jika perlu, ganti kabel tersebut.

2. Hidupkan ulang komputer.

Perangkat tidak bekerja. 1. Ganti perangkat tersebut.

2. Hidupkan ulang komputer.

Port USB pada komputer dinonaktifkan pada Computer Setup. Buka Computer Setup (F10), lalu aktifkan port USB.
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Mengatasi Masalah Akses Internet
Jika Anda mengalami masalah akses Internet, hubungi ISP (penyedia layanan Internet) atau lihat daftar
penyebab umum beserta solusinya dalam tabel berikut ini.

Tabel 2-18  Mengatasi Masalah Akses Internet

Tidak dapat terhubung ke Internet.

Penyebab Solusi

Account ISP (Penyedia Layanan Internet) tidak diatur dengan
benar.

Periksa pengaturan Internet atau hubungi ISP Anda untuk
bantuan.

Modem tidak diatur dengan benar. Ulangi sambungan ke modem. Periksa sambungan sesuai
dokumen pengaturan cepat.

Browser Web tidak diatur dengan benar. Pastikan browser Web telah terinstal dan diatur agar berfungsi
dengan ISP Anda.

Modem kabel/DSL belum terpasang. Hubungkan modem kabel/DSL. LED "daya" yang ada di
bagian depan modem kabel/DSL harus menyala.

Layanan kabel/DSL tidak tersedia atau terganggu akibat
cuaca buruk.

Coba beberapa saat lagi atau hubungi ISP Anda. (Jika layanan
kabel/DSL terhubung, lampu LED "kabel" pada bagian depan
modem kabel/DSl akan menyala.)

Kabel CAT5 UTP tidak terpasang. Sambungkan kabel UTP CAT5 antara modem kabel dan
konektor RJ-45 komputer. (Jika sambungan bagus, lampu
LED "PC" pada bagian depan modem kabel/ DSL akan
menyala.)

Alamat IP tidak dikonfigurasi dengan benar. Hubungi ISP untuk mengetahui alamat IP yang benar.

Cookie bermasalah. ("Cookie" adalah sebagian kecil informasi
yang disimpan sementara oleh server Web melalui browser
Web. Fungsinya adalah agar browser mengambil informasi
yang tersimpan untuk digunakan saat terhubung kembali ke
server Web.)

Windows Vista

1. Pilih Start > Control Panel.

2. Klik Network and Internet.

3. Klik Internet Options.

4. Di bagian Browsing history pada tab General, klik
tombol Delete.

5. Klik tombol Delete cookies.

Windows XP

1. Pilih Start > Control Panel.

2. Klik dua kali Internet Options.

3. Pada tab General, klik tombol Delete Cookies.

Tidak dapat membuka program Internet secara otomatis.

Penyebab Solusi

Anda harus masuk ke ISP terlebih dahulu agar program dapat
dijalankan.

Masuk ke ISP Anda, kemudian buka program yang
dikehendaki.
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Internet terlalu lama dalam menampilkan situs Web.

Penyebab Solusi

Modem tidak diatur dengan benar. Periksa apakah modem sudah terhubung dan berkomunikasi
dengan benar.

Windows XP

1. Pilih Start > Control Panel.

2. Klik dua kali System.

3. Klik tab Hardware.

4. Pada area Device Manager, klik tombol Device
Manager.

5. Klik dua kali Modems.

6. Klik dua kali Agere Systems PCI-SV92PP Soft
Modem.

7. Pada tab General, klik Diagnostics.

8. Klik Query Modem. Respons "Success" menandakan
bahwa modem sudah terhubung dan berfungsi baik.

Windows Vista

1. Pilih Start > Control Panel.

2. Klik System and Maintenance.

3. Klik System.

4. Dalam daftar Tasks, pilih Device Manager.

5. Klik dua kali Modems.

6. Klik dua kali Agere Systems PCI-SV92PP Soft
Modem.

7. Pada tab General, klik Diagnostics.

8. Klik Query Modem. Respons "Success" menandakan
bahwa modem telah terhubung dan berfungsi dengan
baik.

Tabel 2-18  Mengatasi Masalah Akses Internet (Lanjutan)
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Mengatasi Masalah Perangkat Lunak
Umumnya masalah perangkat lunak disebabkan oleh hal berikut:

● Aplikasi tidak diinstal atau dikonfigurasi dengan benar.

● Memori yang tersedia tidak cukup untuk menjalankan aplikasi.

● Konflik di antara aplikasi.

● Pastikan bahwa semua driver perangkat yang diperlukan, telah diinstal.

● Jika Anda telah menginstal sistem operasi selain dari sistem operasi yang diinstal oleh pabrik,
periksa dan pastikan bahwa sistem operasi tersebut didukung oleh sistem komputer.

CATATAN: HP Backup and Recovery Manager dapat digunakan untuk mengembalikan perangkat
lunak ke salah satu titik pemulihan atau mengembalikan sistem ke konfigurasi awal. Lihat HP Backup
and Recovery Manager pada hal. 6 untuk informasi lebih lanjut.

Jika Anda mengalami masalah perangkat lunak, lihat daftar solusi yang sesuai dalam tabel berikut.

Tabel 2-19  Mengatasi Masalah Perangkat Lunak

Komputer berhenti beroperasi dan tidak ada layar logo HP yang muncul.

Penyebab Solusi

Terjadi kesalahan POST. Perhatikan bunyi bip dan LED yang menyala di bagian depan
komputer. Lihat Lampiran A, Pesan Kesalahan POST
pada hal. 49 untuk menentukan kemungkinan penyebabnya.

Lihat Restore Kit atau Jaminan Terbatas di Seluruh Dunia
untuk mengetahui persyaratan dan ketentuan yang terkait.

Komputer berhenti beroperasi setelah layar logo HP muncul.

Penyebab Solusi

File sistem mungkin rusak. Kembalikan file dari Recovery Disc Set atau cadangan yang
dibuat pada HP Backup and Recovery Manager.

Pesan kesalahan "Illegal Operation has Occurred" ditampilkan.

Penyebab Solusi

Perangkat lunak yang digunakan tidak bersertifikasi Microsoft
untuk digunakan pada versi Windows tersebut.

Pastikan bahwa perangkat lunak tersebut bersertifikasi
Microsoft untuk digunakan pada versi Windows Anda (lihat
kemasan program untuk mengetahui informasi ini).

File konfigurasi rusak. Jika mungkin, simpan semua data, tutup semua program, lalu
hidupkan ulang komputer.
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Menghubungi Dukungan Pelanggan
Untuk bantuan dan layanan, hubungi penjual atau agen resmi. Untuk mencari penjual atau agen
terdekat, kunjungi http://www.hp.com.

CATATAN: Jika Anda membawa komputer ini untuk diservis ke agen, penyalur, atau penyedia
layanan resmi, jangan lupa berikan sandi konfigurasi) dan sandi pengaktifan daya komputer, jika ada.

Lihat nomor telepon yang tercantum dalam jaminan atau panduan Nomor Telepon Dukungan untuk
bantuan teknis.
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A Pesan Kesalahan POST

Lampiran ini berisi kode kesalahan, pesan kesalahan, serta berbagai lampu indikator dan kode suara
yang mungkin Anda temui selama POST (Power-On Self-Test) atau ketika menghidupkan ulang
komputer, beserta kemungkinan sumber masalah, serta langkah-langkah yang dapat dilakukan untuk
mengatasi kondisi kesalahan tersebut.

POST Message Disabled akan menghapus sebagian besar pesan sistem selama POST, seperti
hitungan memori dan pesan teks selain kesalahan. Jika terjadi kesalahan POST, layar akan
menampilkan pesan kesalahan tersebut. Untuk beralih secara manual ke mode POST Messages
Enabled ketika POST berlangsung, tekan salah satu tombol (kecuali F10 atau F12). Mode standar
adalah POST Message Disabled.

Kecepatan pengambilan sistem operasi oleh komputer serta tingkat pengujian yang dilakukan
ditentukan oleh pemilihan mode POST.

Quick Boot adalah proses pengaktifan cepat yang tidak menjalankan semua pengujian tingkat sistem,
seperti pengujian memori. Dalam Full Boot, semua pengujian sistem berbasis-ROM akan dijalankan,
sehingga memerlukan lebih banyak waktu.

Full Boot juga dapat diaktifkan untuk dijalankan setiap 1 hingga 30 hari secara berkala. Untuk
menetapkan jadwal boot, konfigurasikan ulang komputer ke mode Full Boot Every x Days,
menggunakan Computer Setup.

CATATAN: Untuk informasi lebih lanjut tentang Computer Setup, lihat Panduan Computer Setup
(F10) Utility.
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Kode Numerik dan Pesan Teks POST
Bagian ini mencakup kesalahan POST yang memiliki kode numerik. Bagian ini juga berisi sejumlah
pesan teks yang mungkin muncul sewaktu POST berlangsung.

CATATAN: Komputer akan berbunyi bip satu kali setelah pesan teks POST ditampilkan di layar.

Tabel A-1  Kode Numerik dan Pesan Teks

Pesan panel kontrol Keterangan Tindakan yang dianjurkan

101-Option ROM Checksum Error Jumlah penghitungan data ROM sistem atau
ROM perangkat tambahan papan tambahan.

1. Pastikan ROM benar.

2. Lakukan penulisan ROM jika
diperlukan.

3. Jika papan tambahan baru
ditambahkan, coba lepaskan untuk
melihat apakah masalah tetap ada.

4. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

5. Jika pesan ini hilang, mungkin terdapat
masalah pada kartu tambahan tersebut.

6. Ganti papan sistem.

103-System Board Failure DMA atau pengatur waktu. 1. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

2. Lepaskan papan tambahan.

3. Ganti papan sistem.

110-Out of Memory Space for Option ROMs Kartu tambahan PCI yang baru saja dipasang
berisi ROM perangkat tambahan yang terlalu
besar untuk didownload dalam POST.

1. Jika kartu tambahan PCI baru
ditambahkan, coba lepaskan untuk
melihat apakah masalah tetap ada.

2. Pada Computer Setup, atur
Advanced > Device Options > NIC
PXE Option ROM Download ke
DISABLE agar pilihan PXE ROM untuk
NIC internal tidak didownload saat
POST berlangsung untuk
mengosongkan lebih banyak memori
pada ROM pilihan kartu ekspansi. ROM
pilihan PXE internal digunakan untuk
menjalankan boot dari NIC ke server
PXE.

3. Pastikan pengaturan ACPI/USB Buffers
@ Top of Memory pada Computer
Setup diaktifkan.

162-System Options Not Set Konfigurasi tidak sesuai.

Baterai RTC (real-time clock) mungkin perlu
diganti.

Jalankan Computer Setup, kemudian periksa
konfigurasi dalam Advanced > Onboard
Devices.

Atur ulang tanggal dan waktu pada Control
Panel. Jika masalah tetap berlanjut, ganti
baterai RTC. Lihat Panduan Referensi
Perangkat Keras untuk petunjuk tentang cara
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

memasang baterai baru, atau hubungi agen
maupun penjual resmi untuk meminta
bantuan dalam mengganti baterai RTC.

163-Time & Date Not Set Waktu dan tanggal tidak valid dalam memori
konfigurasi.

Baterai RTC (real-time clock) mungkin perlu
diganti.

Atur ulang tanggal dan waktu pada Control
Panel (Computer Setup juga dapat
digunakan untuk ini). Jika masalah tetap
berlanjut, ganti baterai RTC. Lihat Panduan
Referensi Perangkat Keras untuk petunjuk
tentang cara memasang baterai baru, atau
hubungi agen maupun penjual resmi untuk
meminta bantuan dalam mengganti baterai
RTC.

163-Time & Date Not Set Jumper CMOS mungkin tidak terpasang
dengan benar.

Periksa apakah jumper CMOS ditempatkan
dengan benar, jika ada.

164-MemorySize Error Jumlah memori telah berubah sejak boot
terakhir (ada memori yang ditambahkan atau
dihapus).

Tekan tombol F1 untuk menyimpan
perubahan memori.

164-MemorySize Error Konfigurasi memori tidak sesuai. 1. Jalankan Computer Setup atau utilitas
Windows.

2. Pastikan modul memori terpasang
dengan benar.

3. Jika ditambahkan memori pihak ketiga,
lakukan pengujian hanya menggunakan
memori HP.

4. Pastikan jenis modul memori telah
sesuai.

201-MemoryError Kegagalan RAM. 1. Jalankan Computer Setup atau utilitas
Windows.

2. Pastikan modul memori terpasang
dengan benar.

3. Pastikan jenis modul memori telah
sesuai.

4. Lepaskan dan ganti modul memori yang
diduga bermasalah.

5. Jika kesalahan terus berlanjut setelah
penggantian modul memori, ganti
papan sistem.

213-Incompatible Memory Module in
Memory Socket(s) X, X, ...

Modul memori dalam soket memori yang
disebutkan dalam pesan kesalahan tersebut
tidak memiliki informasi SPD yang
diperlukan, atau tidak kompatibel dengan
chipset.

1. Pastikan jenis modul memori telah
sesuai.

2. Coba soket memori yang lain.

3. Ganti DIMM dengan modul yang
memenuhi standar SPD.

Peringatan 214-DIMM Configuration Konfigurasi DIMM yang diinstal tidak
dioptimalisasi.

Atur ulang DIMM sehingga setiap saluran
memiliki jumlah memori yang sama.

Tabel A-1  Kode Numerik dan Pesan Teks (Lanjutan)
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

219-ECC Memory Module Detected ECC
Modules tidak didukung oleh Platform ini

Modul memori yang baru saja ditambahkan
mendukung perbaikan kesalahan memori
ECC.

1. Jika ditambahkan memori baru, coba
lepaskan untuk melihat apakah
masalah tetap ada.

2. Lihat dokumen produk untuk
mengetahui informasi tentang
dukungan memori.

301-Keyboard Error Keyboard tidak berfungsi. 1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Periksa konektor untuk memastikan
bahwa tidak ada pin yang tertekuk atau
hilang.

3. Pastikan bahwa tidak ada tombol yang
tertekan.

4. Ganti keyboard.

303-Keyboard Controller Error Pengontrol keyboard pada papan I/O. 1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Ganti papan sistem.

304-Keyboard or System Unit Error Keyboard tidak berfungsi. 1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Pastikan bahwa tidak ada tombol yang
tertekan.

3. Ganti keyboard.

4. Ganti papan sistem.

501-Display Adapter Failure Pengontrol tampilan grafis. 1. Ulangi pemasangan kartu grafis (jika
ada).

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

3. Pastikan bahwa monitor telah
terpasang dan dihidupkan.

4. Ganti kartu grafis (jika mungkin).

510-Flash Screen Image Corrupted Terdapat kesalahan gambar Layar Flash. Flash ulang sistem ROM dengan image BIOS
terbaru.

511-CPU, CPUA, or CPUB Fan not Detected Kipas CPU tidak tersambung atau mungkin
rusak.

1. Ulangi pemasangan kipas CPU.

2. Ulangi pemasangan kabel kipas.

3. Ganti kipas CPU.

512-Chassis, Rear Chassis, or Front Chassis
Fan not Detected

Kipas chassis, chassis belakang, atau
chassis depan tidak tersambung atau
mungkin rusak.

1. Ulangi pemasangan kipas chassis,
chassis belakang, atau chassis depan.

2. Ulangi pemasangan kabel kipas.

3. Ganti kipas chassis, chassis belakang,
atau chassis depan.
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

514-CPU or Chassis Fan not Detected Kipas CPU atau kipas chassis tidak
tersambung atau mungkin rusak.

1. Ulangi pemasangan kipas CPU atau
kipas chassis.

2. Ulangi pemasangan kabel kipas.

3. Ganti kipas CPU atau kipas chassis.

601-Diskette Controller Error Sirkuit pengontrol disket atau sirkuit drive
disket tidak sesuai.

1. Jalankan Computer Setup.

2. Periksa dan/atau ganti kabelnya.

3. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

4. Ganti drive disket.

5. Ganti papan sistem.

605-Diskette Drive Type Error Jenis drive tidak sesuai. 1. Jalankan Computer Setup.

2. Lepaskan perangkat pengontrol disket
lainnya (drive tape).

3. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

660-Display cache is detected unreliable Cache tampilan pengontrol grafis terpadu
tidak berfungsi dengan benar sehingga akan
dinonaktifkan.

Ganti papan sistem jika menimbulkan
masalah penurunan kualitas gambar.

912-Computer Cover Has Been Removed
Since Last System Startup

Penutup komputer dilepaskan sejak
pengaktifan sistem terakhir.

Tidak perlu tindakan apapun.

917-Front Audio Not Connected Rangkaian kabel audio depan tidak
disambungkan atau terlepas dari papan
induk.

Sambungkan kembali atau ganti jaringan
kabel audio depan.

918-Front USB Not Connected Kabel USB depan tidak disambungkan atau
terlepas dari papan induk.

Sambungkan kembali atau ganti kabel USB
depan.

921-Device in PCI Express slot failed to
initialize

Terdapat ketidaksesuaian/masalah pada
perangkat dan sistem atau PCI Express Link
tidak dapat ditahan pada x1.

Coba boot ulang sistem. Jika kesalahan
terjadi lagi, perangkat tersebut tidak dapat
berfungsi pada sistem

1151-Serial Port A Address Conflict Detected Port serial eksternal dan internal dipasang
pada COM1.

1. Lepaskan semua kartu tambahan port
serial.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup atau
utilitas Windows.
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

1152-Serial Port B Address Conflict Detected Port serial eksternal dan internal dipasang
pada COM2.

1. Lepaskan semua kartu tambahan port
serial.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup atau
utilitas Windows.

1155-Serial Port Address Conflict Detected Port serial eksternal dan internal dipasang
pada IRQ yang sama.

1. Lepaskan semua kartu tambahan port
serial.

2. Kosongkan CMOS. (Lihat Lampiran B,
Keamanan Sandi dan Pengaturan
Ulang CMOS pada hal. 61.)

3. Konfigurasi ulang sumber daya kartu
dan/atau jalankan Computer Setup atau
utilitas Windows.

1720-SMART Hard Drive Detects Imminent
Failure

Hard drive akan gagal berfungsi. (Hard drive
tertentu memiliki patch firmware hard drive
yang dapat memperbaiki kekeliruan pesan
kesalahan.)

1. Tentukan apakah hard drive
menampilkan pesan kesalahan yang
benar. Buka Computer Setup,
kemudian jalankan pengujian Drive
Protection System dalam Storage >
DPS Self-test.

2. Jika sesuai, terapkan patch firmware
hard drive. (Tersedia di
http://www.hp.com/support.)

3. Buat cadangan data hard drive,
kemudian ganti hard drive.

1796-SATA Cabling Error Satu atau beberapa perangkat SATA tidak
digunakan dengan baik. Untuk performa
optimal, konektor SATA 0 dan SATA 1 harus
digunakan sebelum SATA 4 dan SATA 5.

Pastikan konektor SATA digunakan dalam
urutan meningkat. Untuk satu perangkat,
gunakan SATA 0. Untuk dua perangkat,
gunakan SATA 0 dan SATA 1. Untuk tiga
perangkat, gunakan SATA 0, SATA 1, dan
SATA 4.

1797-SATA Drivelock tidak didukung dalam
mode RAID.

Drivelock diaktifkan pada satu atau beberapa
hard drive SATA, dan tidak dapat diakses bila
sistem dikonfigurasi untuk mode RAID.

Lepaskan perangkat Drivelocked SATA atau
nonaktifkan fitur Drivelock. Untuk
menonaktifkan fitur Drivelock, buka
Computer Setup, ubah Storage > Storage
Options > SATA Emulation ke IDE, lalu pilih
File > Save Changes and Exit. Buka
kembali Computer Setup, lalu pilih
Security > Drivelock. Untuk setiap
perangkat SATA yang mendukung Drivelock
yang tercantum, pastikan Drivelock pada
posisi Disabled. Terakhir, ubah Storage >
Storage Options > SATA Emulation
kembali ke RAID, lalu pilih File > Save
Changes and Exit.

1801-Microcode Patch Error Prosesor tidak didukung oleh BIOS ROM. 1. Tingkatkan BIOS ke versi yang sesuai.

2. Ganti prosesor.
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

2200-PMM Allocation Error during MEBx
Download

Kesalahan memori saat menjalankan POST
ROM tambahan Ekstensi BIOS Management
Engine (ME)

1. Hidupkan ulang komputer.

2. Lepaskan kabel daya, atur ulang
dudukan modul memori, lalu hidupkan
ulang komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan komputer, pulihkan
konfigurasi awal memori, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, ganti
papan sistem.

2201-MEBx Module did not checksum
correctly

Kesalahan memori saat menjalankan POST
ROM tambahan Ekstensi BIOS Management
Engine (ME)

1. Hidupkan ulang komputer.

2. Lepaskan kabel daya, atur ulang
dudukan modul memori, lalu hidupkan
ulang komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan kabel daya, pulihkan
konfigurasi awal memori , lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, ganti
papan sistem.

2202-PMM Deallocation Error during MEBx
cleanup

Kesalahan memori saat menjalankan POST
ROM tambahan Ekstensi BIOS Management
Engine (ME)

1. Hidupkan ulang komputer.

2. Lepaskan kabel daya, atur ulang
dudukan modul memori, lalu hidupkan
ulang komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan kabel daya, pulihkan
konfigurasi awal memori, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, ganti
papan sistem.

2203-Setup error during MEBx execution Memilih atau keluar dari MEBx
mengakibatkan kegagalan pengaturan.

1. Hidupkan ulang komputer.

2. Lepaskan kabel daya, atur ulang
dudukan modul memori, lalu hidupkan
ulang komputer.

3. Jika konfigurasi memori baru saja
diubah, lepaskan kabel daya, pulihkan
konfigurasi awal memori, lalu hidupkan
ulang komputer.

4. Jika kesalahan terus berlanjut, ganti
papan sistem.

2204-Inventory error during MEBx execution Informasi BIOS yang diteruskan ke MEBx
mengakibatkan kegagalan.

1. Hidupkan ulang komputer.

2. Jika kesalahan terus berlanjut, perbarui
dengan versi BIOS terbaru.

3. Jika kesalahan terus berlanjut, ganti
papan sistem.

Tabel A-1  Kode Numerik dan Pesan Teks (Lanjutan)
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Pesan panel kontrol Keterangan Tindakan yang dianjurkan

2205-Interface error during MEBx execution Operasi MEBx mengalami kesalahan
perangkat keras saat berkomunikasi dengan
ME.

1. Hidupkan ulang komputer.

2. Jika kesalahan terus berlanjut, perbarui
dengan versi BIOS terbaru.

3. Jika kesalahan terus berlanjut, ganti
papan sistem.

Konfigurasi memori tidak diatur dengan
benar.

DIMMI tidak diinstal. Pastikan terdapat modul memori dalam soket
DIMM1 hitam dan terpasang dengan benar.

Invalid Electronic Serial Number Nomor seri elektronik tidak ada. Masukkan nomor seri yang benar dalam
Computer Setup.

Network Server Mode Active and No
Keyboard Attached

Keyboard tidak berfungsi saat Network
Server Mode diaktifkan.

1. Pasang kembali keyboard saat
komputer dalam keadaan mati.

2. Periksa konektor untuk memastikan
bahwa pin tidak tertekuk atau hilang.

3. Pastikan bahwa tidak ada tombol yang
tertekan.

4. Ganti keyboard.

Parity Check 2 Kegagalan Keseimbangan RAM.

Kartu grafis pihak ketiga mungkin
menimbulkan masalah.

Jalankan Computer Setup dan utilitas
Diagnostik.

Lepaskan kartu grafis pihak ketiga untuk
melihat apakah masalah tersebut hilang.

System will not boot without fan Kipas CPU tidak terpasang atau terlepas dari
rangka VSFF.

1. Buka penutup komputer, tekan tombol
daya, lalu lihat apakah kipas prosesor
berputar. Jika kipas prosesor tidak
berputar, pastikan kabel kipas
terpasang ke kepala papan sistem.
Pastikan alat pendingin bertumpu atau
terpasang sepenuhnya.

2. Jika kipas telah terpasang dan alat
pendingin bertumpu dengan baik,
namun kipas tidak berputar, ganti unit
kipas-alat pendingin tersebut.

Tabel A-1  Kode Numerik dan Pesan Teks (Lanjutan)
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Menafsirkan Kode Lampu LED Panel Depan dan Suara
Diagnostik POST

Bagian ini mencakup kode lampu LED panel depan serta kode suara terdengar, yang mungkin terjadi
sebelum atau sewaktu POST dan tidak selalu disertai dengan kode kesalahan atau pesan teks terkait.

PERINGATAN! Bila komputer disambungkan ke stopkontak, selalu ada tegangan pada papan sistem.
Untuk mengurangi risiko cedera dari sengatan listrik dan/atau permukaan panas, pastikan Anda
melepas kabel daya dari stopkontak dan membiarkan komponen sistem internal mendingin sebelum
menyentuhnya.

Cari LED pada papan sistem. Jika LED menyala, sistem masih memiliki daya. Matikan komputer dan
lepaskan kabel daya dari stopkontak sebelum melanjutkan.

CATATAN: Jika Anda melihat LED berkedip pada keyboard PS/2, lihat apakah ada LED yang
berkedip pada panel depan komputer, lalu lihat tabel berikut untuk menentukan kode LED panel
depan.

Tindakan yang disarankan pada tabel berikut ini dicantumkan sesuai urutan pelaksanaannya.

Tidak semua kode lampu dan suara diagnostik tersedia pada semua model.

Tabel A-2  Kode Lampu LED pada Panel Depan dan Kode Suara Diagnostik

Aktivitas Bunyi Bip Kemungkinan Penyebab Tindakan yang Disarankan

LED Daya menyala Hijau. Tidak ada Komputer dalam keadaan
hidup.

Tidak ada

Lampu LED Daya Hijau
berkedip setiap dua detik.

Tidak ada Komputer berada dalam
mode Suspend to RAM
(hanya model tertentu)
atau mode Suspend
normal.

Tidak diperlukan tindakan apapun. Tekan salah
satu tombol agar mouse bergerak untuk
membangunkan komputer.

LED daya berkedip Merah dua
kali, sekali setiap detik, diikuti
dengan jeda dua detik. Bunyi
bip berhenti setelah lima kali
pengulangan, namun LED
terus menyala sampai
masalah teratasi.

2 Perlindungan panas
prosesor diaktifkan:

Kipas mungkin terhalang
atau tidak berputar.

ATAU

Unit pendingin tidak
tersambung dengan baik
pada prosesor.

1. Pastikan ventilasi udara komputer tidak
terhalang dan kipas pendingin prosesor
berfungsi dengan baik.

2. Buka penutup atas, tekan tombol daya, lalu
lihat apakah kipas prosesor berputar. Jika
kipas prosesor tidak berputar, pastikan kabel
kipas tersambung ke kepala papan sistem.

3. Jika kipas telah terpasang, namun tidak
berputar, ganti alat pendingin/unit kipas.

4. Hubungi agen atau penyedia layanan resmi.

LED daya berkedip Merah tiga
kali, sekali setiap detik, diikuti
dengan jeda dua detik. Bunyi
bip berhenti setelah lima kali
pengulangan, namun LED
terus menyala sampai
masalah teratasi.

3 Prosesor tidak terpasang
(bukan merupakan
indikator prosesor rusak).

1. Periksa apakah terdapat prosesor.

2. Ulangi pemasangan prosesor.
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Aktivitas Bunyi Bip Kemungkinan Penyebab Tindakan yang Disarankan

LED daya berkedip Merah
empat kali, sekali setiap detik,
diikuti dengan jeda dua detik.
Bunyi bip berhenti setelah lima
kali pengulangan, namun LED
terus menyala sampai
masalah teratasi.

4 Gangguan daya (catu
daya kelebihan beban).

1. Buka penutup atas dan pastikan kabel catu
daya 4 atau 6 kabel telah terpasang pada
konektor di papan sistem.

2. Periksa apakah terdapat perangkat yang
menyebabkan masalah, dengan
melepaskan SEMUA perangkat yang
terpasang (seperti hard drive, drive disket,
atau drive optik, dan kartu ekspansi).
Hidupkan sistem. Jika sistem memasuki
POST, maka matikan komputer dan pasang
kembali perangkat satu per satu, kemudian
ulangi prosedur di atas hingga gangguan
muncul. Ganti perangkat yang
menyebabkan gangguan tersebut.
Lanjutkan dengan memasang perangkat
satu per satu untuk memastikan semua
perangkat berfungsi dengan benar.

3. Ganti catu daya.

4. Ganti papan sistem.

LED daya berkedip Merah lima
kali, sekali setiap detik, diikuti
dengan jeda dua detik. Bunyi
bip berhenti setelah lima kali
pengulangan, namun LED
terus menyala sampai
masalah teratasi.

5 Kesalahan memori video
awal

PERHATIAN: Untuk menghindari kerusakan
pada DIMM atau papan sistem, Anda harus
melepaskan kabel daya komputer sebelum
mencoba mengatur ulang dudukan, memasang,
atau melepaskan modul DIMM.

1. Ulangi pemasangan DIMM.

2. Ganti DIMM satu per satu untuk menemukan
modul yang bermasalah.

3. Ganti memori pihak ketiga dengan memori
HP.

4. Ganti papan sistem.

LED daya berkedip Merah
enam kali, sekali setiap detik,
diikuti dengan jeda dua detik.
Bunyi bip berhenti setelah lima
kali pengulangan, namun LED
terus menyala sampai
masalah teratasi.

6 Kesalahan grafis video
awal

Untuk sistem yang dilengkapi kartu grafis:

1. Ulangi pemasangan kartu grafis.

2. Ganti kartu grafis.

3. Ganti papan sistem.

Untuk sistem dengan grafis terpadu, ganti papan
sistem.

LED daya berkedip Merah
tujuh kali, sekali setiap detik,
diikuti dengan jeda dua detik.
Bunyi bip berhenti setelah lima
kali pengulangan, namun LED
terus menyala sampai
masalah teratasi.

7 Gangguan papan sistem
(masalah ROM yang
terdeteksi sebelum masuk
ke video)

Ganti papan sistem.

Tabel A-2  Kode Lampu LED pada Panel Depan dan Kode Suara Diagnostik (Lanjutan)
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Aktivitas Bunyi Bip Kemungkinan Penyebab Tindakan yang Disarankan

LED daya berkedip Merah
delapan kali, sekali setiap
detik, diikuti dengan jeda dua
detik. Bunyi bip berhenti
setelah lima kali pengulangan,
namun LED terus menyala
sampai masalah teratasi.

8 ROM tidak valid akibat
pemeriksaan yang buruk.

1. Flash ulang sistem ROM dengan image
BIOS terbaru. Untuk informasi lebih lanjut,
lihat bagian "Boot Block Emergency
Recovery Mode" dalam Panduan
Manajemen Desktop.

2. Ganti papan sistem.

LED daya berkedip Merah
sembilan kali, sekali setiap
detik, diikuti dengan jeda dua
detik. Bunyi bip berhenti
setelah lima kali pengulangan,
namun LED terus menyala
sampai masalah teratasi.

9 Sistem dapat dihidupkan,
namun tidak dapat
melakukan boot.

1. Periksa apakah sakelar pengatur tegangan,
yang terletak di bagian belakang catu daya
(model tertentu), telah diatur ke tegangan
yang benar. Pengaturan tegangan yang
benar tergantung pada negara/kawasan
Anda.

2. Lepaskan kabel dari komputer, tunggu
selama 30 detik, lalu pasangkan kembali
kabel listrik ke komputer.

3. Ganti papan sistem.

4. Ganti prosesor.

LED daya berkedip Merah
sepuluh kali, sekali setiap
detik, diikuti dengan jeda dua
detik. Bunyi bip berhenti
setelah lima kali pengulangan,
namun LED terus menyala
sampai masalah teratasi.

10 Kartu tambahan rusak. 1. Periksa kartu tambahan dengan melepaskan
setiap kartu (satu per satu jika dipasang
banyak kartu), kemudian hidupkan sistem
untuk melihat apakah masalah teratasi.

2. Setelah kartu yang rusak ditemukan,
lepaskan, lalu ganti kartu tambahan yang
rusak tersebut.

3. Ganti papan sistem.

Sistem tidak dapat dihidupkan
dan LED tidak berkedip.

Tidak ada Sistem tidak dapat
dihidupkan.

Tekan terus tombol daya selama kurang dari 4
detik. Jika LED hard drive menyala hijau, tombol
daya berfungsi normal. Coba langkah-langkah
berikut ini:

1. Periksa apakah sakelar pengatur tegangan
(pada beberapa model), yang terletak di
bagian belakang catu daya, telah diatur ke
tegangan yang benar. Pengaturan tegangan
yang benar tergantung pada negara/
kawasan Anda.

2. Ganti papan sistem.

ATAU

Tekan terus tombol daya selama kurang dari 4
detik. Jika LED hard drive tidak berubah hijau,
maka:

1. Periksa apakah unit komputer
disambungkan ke stopkontak yang berfungsi
baik.

2. Buka penutup atas dan periksa apakah kabel
tombol daya telah terpasang dengan benar
ke papan sistem.

3. Periksa apakah kedua kabel catu daya
tersambung dengan benar ke papan sistem.

Tabel A-2  Kode Lampu LED pada Panel Depan dan Kode Suara Diagnostik (Lanjutan)

IDWW Menafsirkan Kode Lampu LED Panel Depan dan Suara Diagnostik POST 59



Aktivitas Bunyi Bip Kemungkinan Penyebab Tindakan yang Disarankan

4. Periksa apakah lampu 5V_aux pada papan
sistem menyala. Jika menyala, maka ganti
rangkaian kabel tombol daya. Jika tetap
bermasalah , ganti papan sistem.

5. Jika lampu 5V_aux pada papan sistem tidak
menyala, lepaskan kartu tambahan satu per
satu hingga lampu 5V_aux pada papan
sistem menyala. Jika tetap bermasalah,
ganti unit catu daya.

Tabel A-2  Kode Lampu LED pada Panel Depan dan Kode Suara Diagnostik (Lanjutan)
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B Keamanan Sandi dan Pengaturan Ulang
CMOS

Komputer ini dilengkapi dengan fitur sandi pengaman, yang dapat ditetapkan melalui menu Computer
Setup Utilities.

Komputer ini mendukung dua fitur sandi pengaman, yang dapat ditetapkan melalui menu Computer
Setup Utilities: sandi konfigurasi dan sandi pengaktifan daya. Jika Anda hanya menggunakan sandi
konfigurasi, setiap pengguna dapat mengakses semua informasi pada komputer, kecuali Computer
Setup. Jika Anda hanya menggunakan sandi pengaktifan daya, sandi tersebut diperlukan untuk
mengakses Computer Setup dan informasi lain pada komputer. Jika Anda menggunakan kedua sandi,
maka hanya sandi konfigurasi yang dapat memberi akses ke Computer Setup.

Jika kedua sandi digunakan, sandi konfigurasi juga dapat menggantikan sandi pengaktifan daya
sebagai pengganti untuk mengakses komputer. Fitur ini sangat berguna bagi administrator jaringan.

Jika Anda lupa sandi untuk komputer, Anda dapat menghapus sandi tersebut dengan mengatur ulang
jumper sandi, sehingga dapat mengakses informasi pada komputer.

PERHATIAN: Menekan tombol CMOS akan mengatur ulang nilai CMOS ke pengaturan default
pabrik. Jangan lupa buat salinan cadangan pengaturan CMOS komputer sebelum mengatur ulang, jika
diperlukan di lain waktu. Pembuatan cadangan dapat dilakukan dengan mudah melalui Computer
Setup. Lihat Panduan Computer Setup (F10) Utility untuk informasi tentang cara membuat cadangan
pengaturan CMOS.
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Mengatur ulang Jumper Sandi
Untuk menonaktifkan fitur sandi pengaktifan daya maupun sandi konfigurasi, atau menghapus sandi
pengaktifan daya maupun sandi konfigurasi, ikuti langkah-langkah berikut:

1. Matikan sistem operasi dengan benar, kemudian matikan komputer dan semua perangkat
eksternal, lalu lepaskan kabel daya dari stopkontak.

2. Setelah kabel daya dilepaskan, tekan kembali tombol daya untuk menghilangkan sisa muatan
listrik dari sistem.

PERINGATAN! Untuk mengurangi risiko cedera pribadi akibat sengatan listrik dan/atau
permukaan yang panas, pastikan Anda melepas kabel daya dari stopkontak dan membiarkan
komponen sistem mendingin sebelum menyentuhnya.

PERHATIAN: Jika komputer tersambung ke sumber listrik, catu daya akan selalu menyalurkan
tegangan ke papan sistem, meskipun komputer dalam dimatikan. Jika kabel daya tidak dilepas,
dapat terjadi kerusakan pada sistem.

Listrik statis dapat merusak komponen elektronik komputer atau peralatan opsional. Sebelum
menjalankan prosedur ini, pastikan Anda telah melepaskan listrik statis dengan menyentuh
sebentar benda logam yang di-ground. Untuk informasi lebih lanjut, lihat Buku Petunjuk Perangkat
Keras.

3. Lepaskan penutup komputer atau panel akses komputer.

4. Cari lokasi header dan jumper.

CATATAN: Jumper sandi berwarna hijau agar dapat dengan mudah dikenali. Untuk bantuan
mencari pengalih sandi dan komponen papan sistem lainnya, lihat Illustrated Parts Map (IPM) pada
sistem tertentu tersebut. IPM dapat didownload dari http://www.hp.com/support.

5. Lepaskan jumper dari pin 1 dan 2. Letakkan jumper pada salah satu pin 1 atau 2, namun jangan
pada keduanya, agar jumper tidak hilang.

6. Ganti penutup atau panel akses komputer.

7. Sambungkan kembali perangkat eksternal.

8. Sambungkan komputer ke sumber listrik, kemudian hidupkan. Biarkan sistem operasi mulai
berjalan. Hal ini akan menghapus sandi dan menonaktifkan fitur sandi.

9. Untuk menetapkan sandi baru, ulangi langkah 1 hingga 4, ganti jumper sandi pada pin 1 dan 2,
kemudian ulangi langkah 6 hingga 8. Buat sandi baru pada Computer Setup. Lihat petunjuk
Computer Setup dalam Panduan Computer Setup (F10) Utility.
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Menghapus dan Mengatur Ulang CMOS
Memori konfigurasi komputer (CMOS) menyimpan informasi tentang konfigurasi komputer.

Tombol CMOS mengatur ulang CMOS, namun tidak menghapus sandi pengaktifan daya dan
konfigurasi.

Mengosongkan CMOS akan menghapus pengaturan Active Management Technology (AMT) dalam
Management Engine BIOS Extension (MEBx), termasuk sandi. Sandi akan ditetapkan secara default
ke "admin" dan harus diatur ulang. Pengaturan AMT juga harus diatur ulang. Untuk mengakses MEBx,
tekan CTRL+P sewaktu POST.

1. Matikan komputer dan semua perangkat eksternal, lalu lepaskan kabel daya dari stopkontak.

2. Putuskan sambungan keyboard, monitor, serta semua perangkat eksternal lain yang tersambung
ke komputer.

PERINGATAN! Untuk mengurangi risiko cedera pribadi akibat sengatan listrik dan/atau
permukaan yang panas, pastikan Anda melepas kabel daya dari stopkontak dan membiarkan
komponen sistem mendingin sebelum menyentuhnya.

PERHATIAN: Jika komputer tersambung ke sumber listrik, catu daya akan selalu menyalurkan
tegangan ke papan sistem, meskipun komputer dalam dimatikan. Jika kabel daya tidak dilepas,
dapat terjadi kerusakan pada sistem.

Listrik statis dapat merusak komponen elektronik komputer atau peralatan opsional. Sebelum
menjalankan prosedur ini, pastikan Anda telah melepaskan listrik statis dengan menyentuh
sebentar benda logam yang di-ground. Untuk informasi lebih lanjut, lihat Buku Petunjuk Perangkat
Keras.

3. Lepaskan penutup komputer atau panel akses komputer.

PERHATIAN: Menekan tombol CMOS akan mengatur ulang nilai CMOS ke pengaturan default
pabrik. Jangan lupa buat cadangan pengaturan CMOS komputer sebelum mengatur ulang, jika
diperlukan di lain waktu. Pembuatan cadangan dapat dilakukan dengan mudah melalui Computer
Setup. Lihat Panduan Computer Setup (F10) Utility untuk informasi tentang cara membuat
cadangan pengaturan CMOS.
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4. Cari tombol CMOS, lalu tekan terus tombol tersebut selama lima detik.

CATATAN: Pastikan Anda telah melepaskan kabel daya dari stopkontak. Tombol CMOS tidak
akan menghapus CMOS jika kabel daya masih tersambung ke stopkontak.

Gambar B-1  Tombol CMOS

CATATAN: Untuk bantuan mencari tombol CMOS dan komponen papan sistem lainnya, lihat
Illustrated Parts Map (IPM) untuk sistem tersebut.

5. Tutup kembali komputer atau panel akses.

6. Sambungkan kembali perangkat eksternal.

7. Sambungkan komputer ke sumber listrik, kemudian hidupkan.

CATATAN: Anda akan menerima pesan kesalahan POST setelah mengosongkan CMOS dan
melakukan boot ulang, yang memberitahukan tentang perubahan konfigurasi. Gunakan Computer
Setup untuk mengatur ulang semua pengaturan khusus sistem serta tanggal dan waktu.

Untuk petunjuk tentang Computer Setup, lihat Panduan Computer Setup (F10) Utility.
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C Drive Protection System (DPS)

Drive Protection System (DPS) adalah alat diagnostik terpadu pada hard disk yang terpasang pada
komputer tertentu. DPS dirancang untuk membantu mendiagnosis masalah yang mungkin
menyebabkan penggantian hard disk yang tidak perlu.

Ketika sistem ini dibuat, setiap hard drive yang terpasang diuji menggunakan DPS, dan informasi
penting akan tertera pada drive tersebut. Setiap kali DPS dijalankan, hasil pengujian akan dicatat pada
hard drive. Penyedia layanan Anda dapat menggunakan informasi ini untuk membantu mendiagnosis
kondisi yang menyebabkan Anda menjalankan perangkat lunak DPS tersebut.

Jika DPS dijalankan, hal ini tidak akan mempengaruhi program atau data yang disimpan pada hard
drive. Pengujian ini berada dalam firmware hard drive dan dapat dijalankan meskipun boot komputer
tidak dapat dilakukan ke sistem operasi. Waktu yang diperlukan untuk menjalankan pengujian
ditentukan oleh produsen serta tergantung pada ukuran hard drive; umumnya, pengujian ini
memerlukan waktu sekitar dua menit per gygabyte.

Gunakan DPS jika Anda menduga terjadi masalah drive. Jika komputer menampilkan pesan SMART
Hard Drive Detect Imminent Failure, Anda tidak perlu menjalankan DPS; namun, buat cadangan
informasi pada hard drive tersebut, kemudian hubungi penyedia layanan untuk mendapatkan hard drive
pengganti.
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Mengakses DPS melalui Computer Setup
Bila pengaktifan daya komputer tidak berlangsung dengan benar, Anda harus menggunakan Computer
Setup untuk mengakses program DPS. Untuk mengakses DPS, ikuti langkah-langkah berikut:

1. Hidupkan atau hidupkan ulang komputer.

2. Jika pesan F10 Setup muncul di sudut kanan bawah layar, tekan tombol F10.

CATATAN: Jika Anda tidak menekan tombol F10 ketika pesan tersebut ditampilkan, Anda harus
mematikan komputer, lalu menghidupkannya kembali, untuk mengakses utilitas tersebut.

Terdapat lima pilihan yang ditampilkan pada menu Computer Setup Utilities: File, Storage,
Security, Power, dan Advanced.

3. Pilih Storage > DPS Self-Test.

Layar akan menampilkan daftar hard drive berkemampuan DPS yang terpasang pada komputer.

CATATAN: Jika tidak ada hard drive yang dapat menjalankan DPS, pilihan DPS Self-Test tidak
akan muncul di layar.

4. Pilih hard drive yang akan diuji, kemudian ikuti perintah di layar untuk menyelesaikan proses
pengujian.

Setelah pengujian selesai, salah satu dari tiga pesan berikut akan ditampilkan:

● Test Succeeded. Completion Code 0.

● Test Aborted. Completion Code 1 or 2.

● Test Failed. Drive Replacement Recommended. Completion Code 3 through 14.

Jika pengujian gagal, kode akhir tersebut harus dicatat dan dilaporkan kepada penyedia layanan Anda
untuk mendapatkan bantuan dalam mendiagnosis masalah komputer.
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